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Preface

About This Guide
This guide explains how to use DEC SoftWindows on your Digital
workstation. It consists of the following chapters:

• Chapter 1 - Introduction
Describes the main features of DEC SoftWindows, and
explains how it enables you to run PC applications on your
Digital workstation.

• Chapter 2 - Using DEC SoftWindows
Explains how to run DEC SoftWindows, describes the key
features of the DEC SoftWindows window, and explains how to
use floppy disks and the keyboard with DEC SoftWindows.

• Chapter 3 - Setting up DEC Softwindows
Describes how to set up DEC SoftWindows emulation of PC
memory, disk drives, and display.

• Chapter 4 - Printing, input, and output
Describes how to set up and use the DEC SoftWindows
serial and output parallel ports for printing, and for serial
communications.

• Chapter 5 - Networking
Describes how to set up and use the DEC SoftWindows
networking support.

• Chapter 6 - Setting up Windows
Explains how to set up Microsoft Windows, and run Windows
applications on your Digital workstation.
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• Chapter 7 - Using MS–DOS
Explains how to give MS–DOS commands, use the MS–DOS
Editor, and install and run MS–DOS applications.

• Chapter 8 - DEC SoftWindows configuration
Gives information about the DEC SoftWindows system
and user configuration files, and describes the MS–DOS
configuration files used by DEC SoftWindows.

• Chapter 9- Displaying Remotely
Provides information for about setting up a DEC SoftWindows
to run on a remote workstation or X terminal.

• Chapter 10 - Troubleshooting
Suggests solutions to problems that you may encounter when
running PC applications on your Digital workstation, and
explains the DEC SoftWindows and MS–DOS error messages.

• Glossary
Describes the technical terms used in the guide.
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Conventions
This guide uses the following conventions:

This style Refers to this

COMPUTER Anything you type, exactly as it appears.

bold Names of menus, menu commands,
buttons, dialog boxes, and windows that
appear on the screen.

Ctrl Special keys on the keyboard.

Return The Return key, also sometimes labeled
Enter.

italics Variables in command lines and system
messages; references to other sections of
this guide.

Abbreviations
This guide uses the following abbreviations:

This abbreviation Refers to this

DEC SoftWindows DEC SoftWindows for Digital workstations

Insignia Insignia Solutions.

MS–DOS Microsoft Disk Operating System for the
IBM PC, or any compatible DOS.

PC An Intel-based computer.

Windows Microsoft Windows 3.1.
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1
Introduction

This chapter describes the main features of DEC SoftWindows
and explains how it enables you to run PC applications on your
OpenVMS AXP workstation.

DEC SoftWindows for OpenVMS AXP Systems

DEC SoftWindows is an X Windows application that runs
on OpenVMS and DEC OSF/1 AXP workstations or servers.
This chapter describes how DEC SoftWindows enables you to
run MS–DOS and Windows applications on your OpenVMS
workstation. Figure 1–1 shows Microsoft Word for Windows
running under Motif using DEC SoftWindows.

Figure 1–1 DEC SoftWindows running Microsoft Word for Windows

DEC SoftWindows emulates a high specification IBM PC/AT
or compatible computer with Windows 3.1 already installed
and ready for use. As Figure 1–2 illustrates, you can run
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most Windows or MS–DOS PC applications on your OpenVMS
workstation alongside your other OpenVMS applications.

Figure 1–2 Simultaneous Windows, MS–DOS, and OpenVMS
Applications on Your Workstation

The DEC
SoftWindows
MS–DOS
Window

DEC SoftWindows runs in a window that emulates the standard
PC display types: Video 7 Super VGA (Video Graphics Array),
EGA (Enhanced Graphics Adapter), CGA (Color Graphics
Adapter), or Hercules.

Indicators in a status bar at the bottom of the DEC SoftWindows
window show you whether special keyboard modes or certain
configuration options are selected.

The Windows
Desktop

DEC SoftWindows also includes color and monochrome Windows
display drivers to optimize the performance of Windows and
to allow it to run in a window of any size on either color or
monochrome displays.

You can switch between your PC application and an OpenVMS
application at any time and copy and paste text between PC and
OpenVMS applications. DEC SoftWindows automatically converts
text cut or copied from Windows applications into the correct
format for pasting into an OpenVMS application.

The DEC
SoftWindows
Menus

The DEC SoftWindows menus provide functions that enable you
to configure DEC SoftWindows to suit your PC applications. You
can do many operations that would require hardware or board
changes on a real PC by choosing the appropriate function from
DEC SoftWindows menus.
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Terminal
Support

DEC SoftWindows also supports most standard terminals that
can be used with your OpenVMS workstation. You can run MDA
(Monochrome Display Adapter) PC applications in text mode from
a VT220 or compatible terminal.

Interfacing DEC SoftWindows

Hard Disks Most PCs have either one or two hard disk drives. These drives
have the fixed names C: and D: under the MS–DOS filing system.
DEC SoftWindows emulates each PC hard disk using a file in the
OpenVMS file system. You can create hard disks of up to 300
Mbyte, subject to the amount of disk space on your workstation.

FSA Drives Using the DEC SoftWindows File Sharing Architecture (FSA),
DEC SoftWindows also lets you access individual files in the
OpenVMS file system as if they were on an MS–DOS drive. FSA
allows you to access the same files from both OpenVMS programs
and PC applications.

Floppy Disk
Drives

Most PCs have 3 1/2-inch floppy disk drives labeled A: and
B:. Standard PC software installations use these drives. DEC
SoftWindows can use the computer’s 3 1/2-inch floppy disk drives
as drive A: or B: to read, write, and format either low density (720
Kbyte), high density (1.4 Mbyte) or extended density (2.88Mbyte)
MS–DOS disks.

CD-ROM DEC SoftWindows includes the Microsoft CD-ROM extensions to
allow PC programs to read PC-format CD-ROMs.

Mouse For PC applications that allow you to use a mouse, DEC
SoftWindows can use an OpenVMS workstation mouse to emulate
the standard PC Microsoft Bus Mouse. When you are running
Windows, the DEC SoftWindows mouse driver automatically
emulates the PC mouse when the mouse pointer is within the
DEC SoftWindows window.

When using MS–DOS applications, you can either choose to
emulate the Microsoft Bus Mouse, or use the mouse for choosing
menu functions and working with other OpenVMS applications.

Keyboard DEC SoftWindows uses the OpenVMS workstation keyboard to
emulate a standard IBM PC/AT keyboard and supports most US,
UK, French, and German keyboards.
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Serial and
Parallel Ports

DEC SoftWindows emulates PC/AT serial ports that MS–DOS
refers to as COM1: to COM4:, and the parallel printer ports
LPT1: to LPT3:.

If your PC application generates output for a printer and you
have a printer available to your OpenVMS workstation, you can
logically attach the appropriate PC port to the OpenVMS print
spooler.

Output from a PC application to any PC port can also be saved
in a file in the OpenVMS file system or sent to the serial ports on
the OpenVMS workstation.

In addition, the serial ports COM1: to COM4: can be attached
to the OpenVMS workstation’s serial ports for full two-way
communication, with selectable baud rate, parity, and word
format.

Networking
Support

Networking support is available for most industry-standard file
servers.

Extended and
Expanded
Memory

You can configure the amount of PC memory using either the PC
Extended memory or Expanded memory system.
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DEC SoftWindows Specifications

Table 1–1 summarizes the DEC SoftWindows specifications.

Table 1–1 DEC SoftWindows Specifications

Feature Specification

Processor 80286 Real and Protected mode

Math co-processor 80287

ROM BIOS PC/AT-compatible

RAM 640 Kbyte

Expanded memory 0 to 32 Mbyte of LIM

Extended memory 1 to 16 Mbyte of XMS

Floppy disk drives Two drives, A: and B:

Hard disk drives Two drives, C: and D:

FSA drives E: to Z:

CD-ROM Data on drive F:

NetWare Support for Novell NetWare file servers on
drives L: to Z:

Video Super Video Graphics Array (Video 7),
Enhanced Graphics Adapter (EGA), Color
Graphics Adapter (CGA), or Hercules.
Super VGA modes supported: 40h to 45h,
and 60h to 69h excluding 63h and 64h.

Parallel ports Three ports, LPT1: to LPT3:

Serial ports Four ports, COM1: to COM4:

Keyboard PC/AT 101/2-key keyboard

Mouse Microsoft Bus Mouse compatible

MS–DOS Version 6.21

Microsoft Windows Version 3.1, runs in standard mode

DEC SoftWindows
driver

Color and monochrome display, and mouse
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Hardware and Software Requirements for Running DEC
SoftWindows

Table 1–2 summarizes the requirements for running DEC
SoftWindows on the OpenVMS AXP operating system.

Table 1–2 Requirements for Running DEC SoftWindows

Feature Specification

System software OpenVMS V6.1 or later. Motif Window
System Version 1.2-2 or later

Memory 32 Mbytes minimum.

Disk space About 40 Mbyte is required to install
DEC SoftWindows. If applications are
installed on the default supplied hard
disk, you may need additional capacity
to allow for maximum expansion of the
hard disk up to 300 Mbyte.

Swap space The swap space should be at least three
times the physical memory size for 32
Mbyte systems, or twice the physical
memory size for larger memory systems.

Floppy disk drives The standard internal and external
3 1/2-inch Digital disk drives are
supported.

Keyboards Digital series LK401 (US/UK, French,
and German), and series PCXAL (US,
UK, French, and German). LK201 series
keyboards can be used by specifying the
LK401 keyboard support.

Terminals VT220 or higher.
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2
Using DEC SoftWindows

This chapter describes how to run DEC SoftWindows, the features
of the DEC SoftWindows window, and how to use floppy disks and
CD-ROMs with DEC SoftWindows.

Using Windows

To Run DEC
SoftWindows
and Display
the Windows
Desktop

To run DEC SoftWindows and display the Windows desktop, type
the following command in a terminal window:

SOFTWINDOWS Return

A standard looking MS–DOS window appears. At the MS–DOS
prompt you can choose either to run MS–DOS applications or to
run MS-Windows by entering the following:

WIN Return

The following dialog box appears after the Windows welcome
screen to allow you to specify the size and position of the window
to use for Windows:

Resize the window by dragging any of the resize corners, then
click OK to run Windows.
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Note

Increasing the size of the window requires more memory
and may reduce performance.

DEC SoftWindows initially runs in a separate Motif window so
you can run Windows and PC applications at the same time as
OpenVMS applications. Figure 2–1 shows a Windows desktop in
a Motif window with many installed applications, most of which
are not provided by DEC SoftWindows.

Figure 2–1 SoftWindows Desktop with Installed Applications

To Run DEC
SoftWindows
from the
Session
Manager

To run DEC SoftWindows from the session manager, you must
first add it to the session manager’s Applications menu:

1. Select Options from the session manager menu bar.

2. Select Applications Definitions.

3. Using the resulting dialog box, in the Menu Item field, enter
the name you want to appear in the Applications menu; for
example, SoftWindows.

4. In the Menu Command field, enter the command:

SoftWindows
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5. Click Add, Apply, and OK.

6. Select Options from the session manager menu bar.

7. Select Applications menu.

8. In the Select item to add column, select SoftWindows.

9. Click Apply and then OK.

The next time you display the session manager’s Applications
pull-down menu, DEC SoftWindows appears as an option.

To Exit from
Windows

Follow these steps to exit from MS Windows:

• If necessary, double-click the Program Manager icon, to
display the Program Manager window.

• From the Program Manager File menu, choose Exit
Windows.
The following dialog box appears:

• Choose OK to exit from Windows to the DEC SoftWindows
MS–DOS window.
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Using MS–DOS

To Display
the DEC
SoftWindows
MS–DOS
Window

To display the MS–DOS window (Figure 2–2):

• Either double-click the MS–DOS Prompt icon in the Main
program group or exit from Windows

Figure 2–2 DEC SoftWindows MS–DOS Window

To Resize
the DEC
SoftWindows
MS–DOS
Window

To resize the DEC SoftWindows MS–DOS window:

• Drag the window by any of its resize corners.

When you release the mouse button the window jumps to the
closest fixed size.

You can resize the DEC SoftWindows window to one of three
alternative fixed sizes: 1.0x, 1.5x, and 2.0x, up to the size of your
workstation screen (or larger).
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Status Bar The status bar, located at the bottom of the window, shows the
status of DEC SoftWindows using the indicators described in the
following table:

Indicator What it means

A: Floppy disk drive A: is in use

B: Floppy disk drive B: is in use

Caps Lock Caps Lock mode is selected

Scroll Lock Scroll Lock mode is selected

Num Lock Num Lock mode is selected

VGA, EGA, or CGA The display type

MSW DEC SoftWindows graphics driver

Note that there is no status bar on the text terminal version of
DEC SoftWindows.

Restarting and Quitting from DEC SoftWindows

To Restart DEC
SoftWindows

To restart DEC SoftWindows:

• From the Actions menu, choose Restart, which is equivalent
to holding down Ctrl Alt Del together on a real PC.
The following dialog box then warns you that you can lose
work if you have not exited from PC applications or saved files
before restarting:

• Click Cancel to cancel the command, or OK to restart.

Note

Holding down Ctrl Alt Del together produces an immediate
restart without the warning dialog box.
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LK201
or LK401
Keyboards

On LK201 or LK401 keyboards, use the decimal point key to the
right of the 0 key on the numeric keypad for the PC key Del .

To Freeze DEC
SoftWindows

Freezing DEC SoftWindows stops it running without affecting the
DEC SoftWindows window. You can use one of two methods to
freeze DEC SoftWindows:

• To freeze whenever you choose, from the Actions menu, select
Freeze. A button appears next to the menu function. To
restart DEC SoftWindows, select Freeze again.

• To automatically freeze DEC SoftWindows whenever you
select another window, from the Options menu, choose Auto
Freeze.

Note

If you select Freeze while running networking software,
network connections may time out.

To Exit
from DEC
SoftWindows

To exit from DEC SoftWindows:

• From the File menu, choose Exit.
The following dialog box then appears to warn you that you
can lose work if you quit without exiting from PC applications
or saving files.

The default is Save Configuration Changes, which saves
any changes you have made to the DEC SoftWindows
configuration file, SWINCONFIG.INI. For more information,
refer to DEC SoftWindows Configuration, Chapter 8.

• Choose OK to exit from DEC SoftWindows or Cancel to cancel
the exit.
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To Quit
Immediately

To quit immediately from DEC SoftWindows, type the following
command in the MS–DOS window:

C:\> EXITSWIN Return

DEC SoftWindows exits immediately without saving any changes
to your DEC SoftWindows configuration.

Using the Mouse

If you have a mouse attached to your computer, you can use it
with MS–DOS programs that support a Microsoft Bus mouse.

To Use the
Mouse Under
MS–DOS

To use the mouse under MS–DOS, either:

• From the Actions menu, choose Attach Mouse, or

• Hold down Ctrl and Alt and click the middle mouse button.
The following dialog box then appears the first time you
choose Attach Mouse:

When you click OK, the workstation mouse disappears, and
other windows and menus become inaccessible.

When you are running Windows, the mouse is automatically
attached and the Attach Mouse menu function is grayed out.

To Restore
the Normal
Workstation
Mouse

To restore the normal workstation mouse, hold down Ctrl and Alt

and click the middle mouse button.
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Using the Keyboard

This section describes the differences in key mapping between
your Digital workstation or VT220 terminal keyboard and a PC
keyboard.

The Keyboard When you use DEC SoftWindows, you must use the Digital
terminal keyboard (Figure 2–3) or workstation keyboards
(Figure 2–4 1 and Figure 2–5) as though they were a PC
keyboard. This section describes which Digital keys change
functions to emulate PC key functions.

Figure 2–3 Digital VT220 Terminal Keyboard
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1 The LK201 diagram, Figure 2–4, includes two errors. (1) Both the left and
right LK201 shift keys map to PC Left Shift. Use the F20 key for PC Right
Shift. (2) The diagram incorrectly shows two keys to the left of the space bar
instead of the single Compose Character key.
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Figure 2–4 Digital LK201 Workstation Keyboard
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Figure 2–5 Digital LK401 Workstation Keyboard
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Motif Retains
Control of the
Left ALT Key

Motif retains control of the left ALT key on the LK201 and LK401
keyboards. Windows uses the left ALT key in key sequences such
as ALT + F5 and ALT + F7, The following solutions enable you to
use the Windows ALT key functions on these keyboards:

• LK201 keyboard—Use the Motif Window Manager to disable
Motif so that all keystrokes go directly to DEC SoftWindows.

• LK401 keyboard—Use the left Compose Character key
for left ALT functions or use the Motif Window Manager
to disable Motif so that all keystrokes go directly to DEC
SoftWindows.
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Keyboard
Mapping—PC
to a Digital
Workstation or
Terminal

Table 2–1 compares the Digital workstation keys and terminal
keyboard keys that function differently with DEC SoftWindows.

Table 2–1 Key Assignments

PC Keyboard
Digital
Workstation Digital VT220 Terminal

Break Help F6

Down arrow 2 (keypad) 2 (keypad)

End 1 (keypad) 1 (keypad)

Escape PF4 PF4

F1 F1 F11

F2 F2 F12

F3 F3 F13

F4 F4 F14

F5 F5 F17

F6 F6 F18

F7 F7 F19

F8 F8 F20

F9 F9 F9

F10 F10 F10

Greater than(>) Shifted period Shifted less than(<)

Home 7 (keypad) 7 (keypad)

Insert 0 (keypad) 0 (keypad)

Left arrow 4 (keypad) 4 (keypad)

Less than (<) Shifted comma less than(<)

Left shift Shift Insert here

Num lock PF1 PF1

Page down 3 (keypad) 3 (keypad)

Page up 9 (keypad) 9 (keypad)

Print screen F13 Help

Right arrow 6 (keypad) 6 (keypad)

Right shift F20 Prev screen

Scroll lock F14 Do

Slash (/) PF2 PF2
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Keyboard
Mapping—Digital
Workstation to
PC

Table 2–2 shows the Digital workstation keyboard keys mapped
to the PC keyboard in increasing Digital scan code order.

Table 2–2 Key Assignments for Digital Workstations

Digital Workstation PC Keyboard

F1 F1

F2 F2

F3 F3

F4 F4

F5 F5

F6 F6

F7 F7

F8 F8

F9 F9

F10 F10

F11 F11

F12 F12

F13 Print Screen

F14 Scroll Lock

Help Break

F17 F17

F18 Right Control

F19 Right Alt

F20 Right Shift

Find Insert

Insert Home

Remove Page Up

Select Delete

Prev End

Next Page Down

(continued on next page)
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Table 2–2 (Cont.) Key Assignments for Digital Workstations

Digital Workstation PC Keyboard

Numeric Keypad

0 Insert

.(period) Delete

Enter Enter

1 End

2 Down Arrow

3 Page Down

4 Left Arrow

5 5

6 Right Arrow

,(comma) +

7 Home

8 Up Arrow

9 Page Up

– -

PF1 Num Lock

PF2 /

PF3 *

PF4 escape

Cursor Keys

Left Arrow Left Arrow

Right Arrow Right Arrow

Down Arrow Down Arrow

Up Arrow Up Arrow

Special Control Keys

Shift Left Shift

Control Left Control

Lock Caps Lock

Compose Left Alt

Del Erase

The remaining keys on the Digital workstation and PC keyboard
are identical.
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Copying and Pasting Text

When DEC SoftWindows is in text mode, you can copy text from
and paste text into the DEC SoftWindows window using the
procedures described in this section.

• Pasting text into the DEC SoftWindows MS–DOS
window

1. Select the text you want to copy by holding down the Select
button (left mouse button), and dragging over the text.

2. Move the mouse pointer over the DEC SoftWindows
MS–DOS window.

3. Click the middle mouse button.
Result—The text is typed into the DEC SoftWindows window
at the current cursor position.

• Copying text from the DEC SoftWindows MS–DOS
window

1. Select the text you want to copy by holding down the
left-hand mouse button and dragging over the text.

2. Move the mouse pointer over the window you want to
paste into.

3. Click the middle mouse button.
Result—The text is typed into the window at the current
cursor position.

• Copying text between Windows and DECterm
DEC SoftWindows includes a utility called SmartCopy to
copy text between MS Windows and a DECterm window.
SmartCopy converts text between the Windows and Motif
clipboards so that you can copy or cut and paste freely
between X Windows and MS Windows applications.
The SmartCopy icon changes to show when the text is ready
to paste as follows:

+ When you move the mouse pointer out of the DEC
SoftWindows window, the icon shows when text is ready to
paste into a Motif application.

+ When you move the mouse pointer into the DEC
SoftWindows window, the icon shows when text is ready to
paste from a Motif application.

Note

Do not select Copy or Paste from the DECterm pull-down
menu.
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Using Floppy Disks

DEC SoftWindows lets you work with 3 1/2-inch MS–DOS format
floppy disks using the floppy disk drives on your OpenVMS
workstation.

Before using floppy disk drive A: or B:, you need to assign it to the
internal 3 1/2-inch floppy disk drive on your workstation. From
the Options menu, select Disk Drives and then select the Open
Drive function (see Setting Up Floppy Disk Drives, Chapter 3.)

To Use a
Floppy Disk

To use a floppy disk:

• Insert the disk into the computer’s internal floppy disk drive.

• To see the contents of the disk from an MS–DOS windows,
enter one of the following commands:

C:\> DIR A: Return

or

C:\> DIR B: Return

• To see the contents of the disk from Windows, use the File
Manager.

To Eject a
Floppy Disk

To eject a floppy disk:

• Press the eject button on the floppy disk drive.

To Format a
Floppy Disk

Before using the MS–DOS command FORMAT, you must first
use the OpenVMS command INITIALIZE to format a floppy
disk. (See Using MS–DOS, Chapter 7.) In the following example,
the floppy device name is DKA300. Your device name may be
different. For example:

$INIT DKA300:/DENSITY=density

where density is one of the following values:

Density Description Size

DD double density 720 Kb

HD high density 1.44 Mbyte

ED extended density 2.88 Mbyte

Use the OpenVMS command SHOW DEVICE/FULL for a
complete description of the disks on your system.

For detailed information on floppy device names, see Setting Up
Floppy Disk Drives, Chapter 3.
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Using CD-ROMs

You can work with MS–DOS format CD-ROMs using a CD-ROM
drive attached to the OpenVMS workstation. DEC SoftWindows
uses drive F: as the CD-ROM drive. Setting Up CD-ROM Drives,
Chapter 3, describes how to set up drive F:.

To Use a
CD-ROM

To use a CD-ROM:

• Enter the USECD command at the MS–DOS prompt:

C:\> USECD Return

This command sets up the CD-ROM drive as drive F:. It
becomes available like any other drive except that it is read
only.
For example, enter this command at the C:\> prompt in an
MS–DOS window to see the contents of the CD-ROM:

C:\> DIR F: Return

To Eject a
CD-ROM

To eject a CD-ROM:

• Press and hold the eject button on the front of the CD-ROM
drive.

Using Sound

To alternately enable and disable the OpenVMS workstation’s
sound facilities:

• From the Options menu, click on Sound to turn sound on or
off.
When sound is enabled, a button appears next to the Sound
menu option as shown below:

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options
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Note

DEC SoftWindows cannot emulate complex sounds, such
as digitized voices or music. Attempting to run a PC
application with sound substantially slows down your PC
application. To avoid this problem, turn the sound off in
the PC application. Using the Sound function will not
solve the performance problem since the PC application
continues to do the sound processing.

Using FPU Emulation

To alternately enable and disable the FPU Emulation function:

• From the Options menu, click on FPU Emulation to turn
the function on or off.
When FPU emulation is enabled, a button appears next to the
FPU Emulation menu option as shown below:

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options

Note

MS–DOS applications written to use the 80287 chip must
have FPU emulation enabled as shown in the figure above.
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Activating and Deactivating Drives and Ports

Use the Activate function to control which of the PC drives or PC
ports are reserved for use by DEC SoftWindows. The possible PC
drives are A: to D:. The possible PC ports are LPT1: to LPT3: or
COM1: to COM4:.

DEC SoftWindows tries to activate a drive or port when it is first
selected, according to the settings in the Open Disk Drives,
Comms Ports, and Printer Ports dialog boxes; refer to Setting
Up Drives, Chapter 3 and Printing, Input, and Output, Chapter 4.

To See Which
Services Are
in Use by DEC
SoftWindows

To see which services are in use by DEC SoftWindows:

• From the Actions menu, choose Activate.
The following cascade menu then appears:

Flush Ports

Activate

Attach Mouse

Freeze

Restart

Actions

A Drive

C Drive

D Drive

LPT 1

LPT 2

LPT 3

COM 1

COM 2

COM 3

COM 4

MLO-007287

B Drive

The buttons next to device names in the cascade menu indicate
devices in use by DEC SoftWindows. Entries with no device
assigned to them are shown grayed out in the menu.

To Free a
Device for Use
by OpenVMS
Applications

To free a device for use by OpenVMS applications:

• From the Actions menu, choose Activate.

• From the Activate cascade menu, choose the corresponding
drive or port.
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To Set
Read-only
Access on
Hard Disk
Drives

To set read-only access on hard disk drives:

• From the Actions menu, choose Activate.

• From the Activate cascade menu, choose C Drive or D
Drive.

Any number of users can have read access to a hard disk file, but
only one can have write access at a time. A button shown beside
a drive name indicates that you have read and write access; other
users have read access only. If no button appears beside a drive
name, you have read access only, which allows another user to
write to the drive.
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3
Setting up DEC SoftWindows

This chapter describes how to configure a PC to your specifications
using selections from the DEC SoftWindows Options menu to
emulate PC memory, disks, and displays:

• Memory—Use this function to set up the amount of Extended
or Expanded memory you need.

• Disk Drives—Use this function to specify how the PC hard
disk drives are emulated on the workstation.

• Display— Use this function to choose DEC SoftWindows
emulation of a PC display adapter.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options

Restarting DEC SoftWindows

After changing any of these preferences, which correspond
to a hardware change on a real PC, you must restart DEC
SoftWindows.
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The following dialog box appears to warn you and give you the
option of canceling the change:

Setting Up Memory

The standard amount of memory available on a PC is 640 Kbyte.
DEC SoftWindows supports two methods to increase this memory:
Extended memory and Expanded memory. The method you choose
depends on your PC application. The following table describes the
differences between Extended memory and Expanded memory:

Type of PC
memory Description

Main
(Extended)
memory

Also referred to as XMS memory (Extended
Memory Specification). Used by more recent
applications, including Windows. Requires a
protected-mode 80286.

Expanded
memory

Also referred to as LIM or EMS (Lotus, Intel,
Microsoft Expanded memory specification). Used
by earlier real-mode PC applications.

Memory
Performance
Hints

The following performance hints may help you decide how to set
up the PC memory:

• Set only the amount of memory your application needs.
Choosing too much memory may reduce performance.

• If your application can use either type of memory, Digital
recommends Main (Extended) memory, which is accessed
faster than Expanded memory.

• Replace conventional memory with Expanded memory only if
your MS–DOS application specifies backfilling.

• Selecting between 4 and 8 Mbytes of Main Memory and 0
Mbytes of Expanded Memory gives the best performance for
most applications.
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To Specify the
PC Memory

To specify the PC memory, use the following procedure:

• From the Options menu, choose Memory.
The following dialog box shows the amount of Main (Extended)
memory and Expanded memory and allows you to change it:

• Select the amount of Main memory by dragging the top slider,
labeled Main Memory Size, until the value you want is
shown above the slider.

• Select the amount of Expanded memory by dragging the
bottom slider, until the value you want is shown above the
slider then click OK to restart DEC SoftWindows with the
memory configuration.
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Setting Up Drives

PCs use the drive letters A: to Z: to identify individual disk
drives.

You can set up the floppy disk drives A: and B:, the hard disk
drives C: and D:, the FSA drive E:, and the CD-ROM drive F:.
From the Options menu, select Disk Drives, then Open Drive.
You can use the NET USE command in the AUTOEXEC.BAT file
to set up the FSA drives G: and H:.

The following table shows the meaning of each drive letter and
how each is set up when you first install DEC SoftWindows:

Drive Default Description

A: Empty The floppy disk drive.

B: Empty Additional floppy disk drive

C: MS-WIN-31.HDF The startup, or boot, hard disk
drive

D: Empty Additional hard disk drive

E: SYS$LOGIN Your home directory

F: Empty The CD-ROM drive

G: SWIN$HOME:[windows]

The Windows data directory

H: SYS$LOGIN Your home directory

Using Hard
Disk Files

DEC SoftWindows emulates PC hard disks using single files in
the OpenVMS file system with the extension .HDF. The individual
MS–DOS files within DEC SoftWindows hard disk files are
accessible only from within DEC SoftWindows and cannot be
listed using OpenVMS commands.

DEC SoftWindows hard disk files can be attached to and detached
from either of the PC drives C: and D: without affecting the
information stored within the hard disk file.

DEC SoftWindows always uses drive C: to start up unless a floppy
disk is in an attached A: disk drive. This means you must always
have a bootable DEC SoftWindows hard disk file attached to
drive C:. This hard disk file must include the MS–DOS start-up
files, which must be installed when the hard disk file is created.
DEC SoftWindows is supplied with a drive C: container file called
MS-WIN-31.HDF.
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To Choose the
Hard Disk File
for C: or D:

To choose the hard disk file for C: or D:, use the following
procedure:

• From the Options menu, choose Disk Drives, then Open
Drive.
The following dialog box appears to show the hard disk files
assigned to drives C: and D:.

• Either type the name you require in the text box or click
Hard Disk Drive C: File Name or Hard Disk Drive D:
File Name to change the hard disk file used for drive C: or
D:, respectively.
The following dialog box lets you select the hard disk file to
use:

• Choose the name of the file you want to use and click OK to
restart DEC SoftWindows with the drive configuration you
have specified.
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To Set Up a
New D: Drive
File

To set up a new file to contain the D: drive, use the following
procedure:

• Make sure that you have enough OpenVMS disk space for
the file you are creating; you can use the OpenVMS SHOW
DEVICE command to check the available disk space.

• From the Options menu, choose Disk Drives, then New
Drive.
The following dialog box appears:

• Enter a name for the new hard disk file. It is recommended
you give the file a .HDF extension.

• Choose the size by dragging the slider until the size you want
is shown above the slider.

• Click OK to set up the hard disk file you have specified.

Creating a New
Hard Disk

To create a new hard disk within the file set up as described
above, you must:

• Select the size for your new disk

• Partition the disk

• Choose to create the disk as either a bootable or nonbootable

The following sections describe how to do each of these steps.

Selecting the
Disk Size

To select the disk size, use the following procedure:

• From the Options menu, select Disk Drives, then New
Drive.
The following dialog box appears:
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• Enter the name of the disk. If you omit directory information,
DEC SoftWindows places the file in the directory that was
current when you invoked DEC SoftWindows. Enter a
complete file specification to place the file in a different
directory.

• Place your cursor on the slide bar and move the marker to the
desired size. Click on OK.
The example shown creates a 150-Mbyte container file named
NEWDRIVE.DOS.
The file is created and DEC SoftWindows restarts with
NEWDRIVE.DOS installed as your D: drive.

Partitioning the
Disk

To partition the disk, run the MS–DOS program FDISK and use
the following procedure:

• To run the FDISK program, enter the following command at
the MS–DOS prompt:

C:\> FDISK Return

• Enter option 5 from the FDISK menu for your second hard
disk:

Enter choice [5] Return

• FDISK displays the disks on your system, Now enter the disk
number that shows 0% usage and press Return

• Enter Option 1 to create an MS–DOS partition.

• From the next menu, enter Option 1 for a primary partition.

• Enter Y to use the whole disk as a standard MS–DOS
partition unless you have special requirements.

• Press Esc to return to FDISK options

• Press Esc again to exit FDISK

• Press any key to reboot DEC SoftWindows.
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Choosing
to Create a
Bootable or
Nonbootable
Disk

Hard disks can be bootable or nonbootable. You determine which
type you need:

• A bootable disk contains the MS–DOS operating system and
other files. It is known as drive C:.

• A nonbootable disk contains application programs. It is known
as drive D:.

Do not make a new C: drive using system files from a C: drive
that contained a previous version of DEC SoftWindows.

For the following instructions, the C: drive must be either the C:
hard disk drive that came with DEC SoftWindows or a copy of it.

To create a bootable drive, issue the following commands:

C:\> FORMAT D:/S Return

Enter Y Return

C:\> XCOPY C: D:/S Return

C:\> MAKEBOOT 1 Return

To create a nonbootable drive, issue the following commands:

C:\> FORMAT D: Return

Enter Y Return

Optional
Method to
Create a
Bootable Disk

The XCOPY command shown in the above procedures copies
all files from your existing DEC SoftWindows C: drive to your
newly-created D: drive. If you do not need to copy the entire disk,
you may copy only essential files from the C: disk to the D: disk.

To create a bootable disk containing only essential files, issue the
following commands:

C:\> FORMAT D:/S Return

Enter Y Return

C:\> MKDIR D:\DOS Return

C:\> MKDIR D:\INSIGNIA Return

C:\> COPY C:\DOS\*.* D:\DOS\*.* Return

C:\> COPY C:\INSIGNIA\*.* D:\INSIGNIA\*.* Return

C:\> COPY C:CONFIG.SYS D: *.* Return

C:\> COPY C:AUTOEXEC.BAT D: *.* Return

C:\> MAKEBOOT 1 Return

To Remove the
Hard Disk File

To remove the hard disk file, use the following procedure:

• From the Options menu, choose Disk Drives, then Open
Drive to show the hard disk files attached to C: and D:.

• Delete the name of the hard disk file in the Hard Disk Drive
D: File Name text box.
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• Click OK to restart DEC SoftWindows with the drive
configuration you have specified.

To Install
Windows

To install Windows on a new hard disk file, you need to run the
Windows Setup program, using the files provided in the Windows
data directory.

To install Windows, use the following procedure:

• Create a new hard disk file on drive D:. Refer to To Create a
New D: Drive earlier in this chapter.
The size of the new disk should be not less than 11Mbyte
to provide space for Windows, but at least 20 Mbyte is
recommended.

• Remove the hard disk file from the D: drive and assign it as
the C: drive.

• Run the Windows Setup program in the Windows data
directory (attached as the FSA drive G: by default) by typing:

C:\> G:\SETUP Return

• When the installation is complete, exit from DEC SoftWindows
to ensure that all the files close correctly.

• Run DEC SoftWindows and then run Windows on the new
drive in the usual way. Refer to Using Windows, Chapter 2.

Note that the Windows setup procedure automatically installs
a program called Smartdrive, which reduces performance when
used with DEC SoftWindows. Digital recommends that you
remove the line

C:\WINDOWS\SMARTDRV.EXE

from the AUTOEXEC.BAT file after installing Windows on a hard
disk file.

If you are going to print PostScript files from Windows, follow
the instructions in the file PRINTERS.WRI to insert a statement
CtrlD=0 in the WIN.INI file.
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Setting Up File Sharing Architecture (FSA) Drives

DEC SoftWindows includes software called the File Sharing
Architecture (FSA) that allows MS–DOS files to be stored in the
OpenVMS file system and still be accessed by MS–DOS and PC
applications as though they were on an MS–DOS disk.

In the case of a real PC, an FSA drive would be on another
computer and MS–DOS would access it through a software driver.
DEC SoftWindows uses this attribute of MS–DOS to access a
specified OpenVMS directory, which can be on your workstation’s
hard disk or mounted from a remote file server, according to your
needs.

The MS–DOS files in an FSA drive are individual OpenVMS
files and can be used by OpenVMS programs that can work with
MS–DOS files.

Filenames in
MS–DOS

Not all OpenVMS filenames are valid as MS–DOS names. You
should adhere to the MS–DOS filename conventions when
creating files in the OpenVMS file system that you want to access
from DEC SoftWindows.

MS–DOS filenames have the form:

name.ext

where name is eight characters or less, and ext is an optional
three character or less extension.

Filenames can include the letters A-Z, the digits 0-9, and the
following symbols:

_ ! # $ % & @ ^ ~

However, all of these characters except _ (underscore) are special
characters in OpenVMS, so you should avoid them in filenames.

When accessing OpenVMS files using an FSA drive, an illegal
MS–DOS filename that does not adhere to the above restrictions
is converted to a legal name, although it may not be accessible to
MS–DOS if another file of the same name already exists.

To Set up
an OpenVMS
Directory as PC
Drive E:

To set up an OpenVMS directory as PC drive E:, use the following
procedure:

• From the Options menu, choose Disk Drives, then Open
Drive.
The following dialog box shows the OpenVMS directory
assigned to drive E:.
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• Type the directory you want to use into the text box, or click
FSA Root Directory Name.
The following dialog box allows you to select the OpenVMS
directory to use as drive E:.

• Locate the directory you want to use, and choose OK.

• Choose OK to exit from the Open Disk Drives dialog box
with the drive configuration you have specified.

To Set Up
OpenVMS
Directories as
Drives E: to Z:

To set up OpenVMS directories as drives E: to Z:, use the
following procedure:

• Type the following command at the MS–DOS C:\> prompt:

C:\> NET USE x: dir Return

where x: is the letter of the drive you want to assign to
the directory, and dir is the full OpenVMS pathname of the
directory.
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For example, in the following example, a user named Smith
assigns J: to the subdirectory DOS in his home directory:

NET USE J: [SMITH.DOS] Return

The drive can be any letter from E: to Z: (subject to the setting
of LASTDRIVE). Drives A: to D: are predefined by MS–DOS.
The CONFIG.SYS file on the hard disk supplied with DEC
SoftWindows sets LASTDRIVE to K:.

Equally, if you set up a hard disk with more than one partition
and assign the first partition as drive D:, MS–DOS uses drive E:
for the second partition, drive F: for the third, and so on. In this
case, you need to use subsequent letters for any FSA drives you
set up.

You can include the appropriate NET USE command in your
AUTOEXEC.BAT file if you want the drives to be set up each
time you run DEC SoftWindows.

When attaching to a NetWare file server, the login drive uses
the letter that follows the letter assigned to LASTDRIVE in the
CONFIG.SYS file; by default the login drive is L:. All drives
not included with the LASTDRIVE command are available to
NetWare and can be assigned with the NetWare MAP command.

To Remove
an OpenVMS
Directory from
a Drive

To remove an OpenVMS directory from a drive, use the following
procedure:

• Type the following command at the C:\> prompt:

C:\> NET USE x: /D Return

where x: is the letter of the drive you want to remove. This
does not delete the directory but removes the pointer to it.

To List the
OpenVMS
Directories
Attached to
Drives

To list the OpenVMS directories attached to drives, use the
following procedure:

• Type the following command:

C:\> NET USE Return

This command lists the drive letter of each FSA drive, and the
pathname of the directory to which it has been attached. If
the command is given with a drive letter, it shows the current
selection for that drive.

Sharing
and Using
Text Files in
OpenVMS and
MS–DOS

OpenVMS and MS–DOS store text files in slightly different
formats. If you create a text file under OpenVMS and want
to edit it from MS–DOS, or vice versa, you may find that the
format is wrong. On the OpenVMS system, use SOFTWINDOWS
command qualifiers /DOS_TO_VMS and /VMS_TO_DOS to
convert files.

• The qualifier /DOS_TO_VMS converts MS–DOS files to
OpenVMS format. For example,
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$SOFTWINDOWS/DOS_TO_VMS DOSFILE.DAT VMSFILE.DAT

converts the file DOSFILE.DAT to an OpenVMS formatted file
called VMSFILE.DAT.

• The qualifier VMS_TO_DOS converts OpenVMS files to
MS–DOS format. For example,

$SOFTWINDOWS/VMS_TO_DOS VMSFILE.DAT DOSFILE.DAT

converts the file VMSFILE.DAT to an MS–DOS formatted file
called DOSFILE.DAT.

The following table shows when to convert files:

Created by
OpenVMS Created by DOS

Used by VMS OK Convert using DOSTOVMS
command

Used by DOS Convert using
VMSTODOS
command

OK
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Setting Up Floppy Disk Drives

You can set up DEC SoftWindows to use the internal or external
3 1/2-inch floppy disk drives on your workstation as the PC drives
A: and/or B: to work with MS–DOS format 3 1/2-inch floppy disks.

To Set Up the
Floppy Disk
Drives A: and
B:

To set up the floppy disk drives A: and B:, use the following
procedure:

• From the Options menu, choose Disk Drives, then Open
Drive.
The following dialog box shows the devices assigned to the
floppy disk drives A: and B:.

• Type the floppy disk drive device name into the appropriate
text box labeled Floppy Drive A: Device File Name or
Floppy Drive B: Device File Name.
Use a device name such as DKA300: or, for the AXP 150,
DVA0:.

• Choose OK to reset DEC SoftWindows with the drive
configuration you have specified.

To Deassign a
Floppy Disk
Drive

To deassign a floppy disk drive, use the following procedure:

• Delete the device name from the text box labeled Floppy
Drive A: Device File Name or Floppy Drive B: Device
File Name, as appropriate. You might need system privileges.
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Setting Up CD-ROM Drives

DEC SoftWindows allows you to read data CD-ROMs that are
compatible with the Microsoft CD-ROM Extensions (MSCDEX) as
MS–DOS drives.

The CD-ROMs can be read by MS–DOS commands, if appropriate,
or by executing the relevant application programs (which are
often on the CD-ROM itself).

To Set Up the
CD-ROM Drive

To set up the CD-ROM drive, use the following procedure:

• From the Options menu, choose Disk Drives, then Open
Drive.
The Open Disk Drives dialog box shows the device assigned
to the CD-ROM drive.

• Type the CD-ROM drive device name (DKA400:, for example)
into the text box labeled CD-ROM Device File Name.

You can now use the CD-ROM with DEC SoftWindows. Refer to
Using CD-ROMs, Chapter 2.

MS–DOS
Configuration

The MS–DOS program USECD executes the following command
to assign the CD-ROM to drive F:.

MSCDEX /D:CDROM$$$ /L:F

Include this line in your AUTOEXEC.BAT file if you want to use
CD-ROMs each time you run DEC SoftWindows.

MSCDEX
Options

The MSCDEX command accepts the following parameters:

Parameter Function

/D: device Specifies the device driver to be used. For DEC
SoftWindows, it is CDROM$$$.

/M: buffers Sets the number of buffers. The buffers parameter
should be at least 5, but a larger value, such as 20,
improves performance.

/E: Uses Expanded memory if it is installed and
available.

/V: Displays additional information about memory usage
during initialization.

/L: drive Assigns the drive at the drive letter given, rather
than the next available.
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Setting Up the Display

DEC SoftWindows provides emulation of all the main PC display
adapter types. The following table shows, in order of precedence,
which display option to choose for your PC application, and which
DEC SoftWindows display option to use:

For this PC option Choose this setting

Super VGA,
Video 7,
VGA

VGA

EGA EGA

CGA CGA

Hercules Hercules

Other Try VGA first, then CGA.

Digital recommends that you use the Hercules option if you have
a monochrome display.

To Specify
the Display
Adapter

To specify the display adapter, use the following procedure:

• From the Options menu, choose Display.
The following dialog box shows the display adapter currently
selected:

• Choose the Display Type you want to use by clicking the
appropriate button.

• Choose OK to reset DEC SoftWindows with the display
settings you have chosen.
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To Specify
the Number
of Colors for
Windows

To specify the number of colors for windows, use the following
procedure:

• Choose 16 or 256 in the Display dialog box.
Selecting 16 leaves more colors free for your other applications.
If only 16 colors are available, the 256 option is grayed out.

Windows
Change Color

If you choose 256 colors, then all your OpenVMS windows will
change color when you are using DEC SoftWindows. This is
normal and is caused by the PC emulator loading the OpenVMS
color map with a PC color map. Normal colors appear when you
click back into the OpenVMS windows.
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4
Printing, Input, and Output

PC applications use the COM1: to COM4: serial ports and the
LPT1: to LPT3: parallel ports to communicate with external
devices such as printers, modems, and data loggers. This chapter
describes how to assign these ports to take advantage of the
equivalent capabilities of the OpenVMS AXP workstation.

COM and LPT Port Options

When you install DEC SoftWindows, all the COM and LPT port
options are undefined. Before you can perform any operations
to these ports, you must explicitly define them using device and
queue specifications that are valid for your site. This chapter
explains how to use the DEC SoftWindows menus and dialog
boxes to define the ports.

The COM and LPT port options are:

Port Description

File for output redirected to a specified file

Print Queue for output sent to an OpenVMS print queue

DataComm for input/output to the workstation serial port

Printer for output connected to the workstation serial
port

Plotter for output to a plotter connected to the
workstation serial port

None for no device assigned

Flushing Output to a File

The PC print environment differs from the OpenVMS print
environment. PCs do not always print an entire file—sometimes a
portion of the file remains in a buffer. So after sending date from
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a DEC SoftWindows COM or LPT port out to a file, you need to
flush the output to ensure that the last partial buffer of data has
been sent.

DEC SoftWindows allows you to flush output either automatically
or manually. The Auto Flush option flushes the buffer
automatically a specified time after the last activity on the port.
Alternatively, you can flush output from a port manually when
you know that output has finished.

To Flush
Output
Automatically

To flush output automatically, use the following procedure:

• From the Options menu, choose Auto Flush.
The following dialog box then appears:

• Check that the Enable Automatic Flushing box is selected.

• Set the required delay either by moving the Autoflush Delay
slider until the field shows the value you want or by typing
the value into the box. You can set any autoflush delay from 1
to 50 seconds.

The ideal autoflush delay depends on how quickly the PC
application sends data. You may need to experiment by starting
with a high value, then reducing it, to find the best setting.

To Flush
Output
Manually

To flush output manually, use the following procedure:

• Choose Flush Ports from the Actions menu.
A cascade menu then appears, allowing you to select which
ports to flush.

• Either choose All to flush all ports or choose the specific port
you want to flush.

• Choose Flush after sending data out with the Pipe option to a
COM or LPT port.

The buffers are also flushed automatically when you quit from
DEC SoftWindows.
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Printing from PC Applications

DEC SoftWindows provides two printing options:

• DEC SoftWindows can use the standard print spooler to print
to a local or a network printer.

• DEC SoftWindows can drive a PC printer directly connected to
a serial port so that your application can print directly to it.

The best option to select depends on your printer and the printers
supported by the PC application.

You then need to:

• Set up the PC application to print to the type of printer you
are going to use.

• Set up DEC SoftWindows to provide the appropriate printer
emulation.

How you configure MS–DOS applications depends on the
application. For Windows applications use the Print Manager.

Note that additional information about printing from Windows is
provided in the file C:\WINDOWS\PRINTERS.WRI.

To Print to
the OpenVMS
Printer

To print to the OpenVMS printer, use the following procedure:

• From the Options menu, choose COM/LPT Ports.

• From the COM/LPT Ports cascade menu, choose Printer
Ports.
The Printer Ports dialog box then appears:

• Choose Print Queue from the LPT1: popup menu. Note that
SYS$PRINT is the default setting, which sends output to the
local print spooler.

• Check that Enable Automatic Flushing is set in the Auto
Flush dialog box.
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To Print to a
Serial Printer
with Default
Settings

You can print from an LPT port to a serial printer with the
following fixed communications settings:

9600 baud
no parity
8 data bits
1 stop bit
XON/XOFF handshaking

To print to a serial printer with default settings, use the following
procedure:

• Connect the printer to the serial port.

• From the Options menu, select COM/LPT Ports.

• From the COM/LPT Ports cascade menu, select Printer
Ports.
The Printer Ports dialog box then appears.

• Select the Printer option from the LPT1: popup menu. By
default this selection sends output to one of the serial ports.
Depending on which port you are using, you may need to
change this selection.

To Print to a
Serial Printer
With Selectable
Settings

If you need to use communications settings other than the
defaults, set a COM port to Printer and use the MODE command
to set the communications parameters. For example, the
command

MODE COM1:9600,N,8,1

sets 9600 baud, no parity, 8 data bits, and 1 stop bit, the default
setting. XON/XOFF handshaking is supported.

If your application can only print to an LPT port, use the MODE
command to direct LPT output to the COM port. For example:

MODE LPT1:=COM1:

Include the MODE commands in your AUTOEXEC.BAT file if you
want to use these settings every time you run DEC SoftWindows.
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Redirecting to a File

You can redirect all output from a specified port to a file in the
OpenVMS file system. Redirecting output from DEC SoftWindows
to a file is a useful way of debugging problems with printing. The
file can then be printed externally to DEC SoftWindows.

Note

Your VMS editor will not be able to read the print file
if it is in DOS format. In this case, you need to use the
SOFTWINDOWS/DOS_TO_VMS command to convert the
file and adjust the carriage returns and line feeds. For
details, see Sharing and Using Text Files in OpenVMS and
MS–DOS, Chapter 3, or type

$ HELP SOFTWINDOWS

To Redirect
Output to a File

To redirect output to a file, use the following procedure:

• From the Options menu, choose COM/LPT Ports.

• From the COM/LPT Ports cascade menu, choose Printer
Ports or Comm Ports, depending on whether you want to
redirect an LPT or COM port.
Either the Printer Ports or Comm Ports dialog box then
appears:

• Choose File from the popup menu corresponding to the port
you want to redirect.

• Either use the default, the filename SOFTWIN.LIS in your
home directory or enter the filename you want to use. If the
file already exists the output will be appended to it.

• Check that Enable Automatic Flushing is set in the Auto
Flush dialog box to flush output to the file; refer to Flushing
output to a file, earlier in this chapter.
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Serial Input and Output

Using the DataComm option, you can attach a COM port
with selectable serial parameters to either of the serial ports
for input and output. This option is intended to be used for
communications packages that provide their own handshaking.

The following serial baud rate parameters are supported:

50 75

110 134.5

150 300

600 1200

1800 2400

4800 9600

The following combinations are supported:

Data bits Parity Stop bits

8 None 1

7 Even 1

7 None 2

7 Odd 1

By default, COM1: is set up by the following MODE command in
the AUTOEXEC.BAT file:

MODE COM1:9600,N,8,1

This command gives the following communications settings: 9600
baud, no parity, 8 data bits, and 1 stop bit.

Issue another MODE command to change these settings.
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To Use Serial
Input and
Output

To use serial input and output, use the following procedure:

• Connect the serial device to the workstation’s serial port.

• From the Options menu, select COM/LPT Ports.

• From the COM/LPT Ports cascade menu, choose Comm
Ports.
The Comms Ports dialog box then appears:

• Choose DataComm from the COM1: popup menu, then enter
the appropriate device name for the port you want to use. If
necessary, ask your system administrator for the name of that
device.

Serial Port
Emulation

DEC SoftWindows uses facilities provided by the OpenVMS
terminal device drivers to determine the state of the serial port.
This means that the PC/AT serial port cannot be fully emulated,
although most devices and packages designed to operate with it
work equally well on DEC SoftWindows.

The following technical details are for users who need specialized
help in getting a device or package to work properly or who are
developing software that uses the serial ports.

• DSR (Data Set Ready)—The DSR signal is always held high.
The effect is that devices can detect DTR (Data Terminal
Ready), but a response from the device via DSR cannot be
detected by DEC SoftWindows. Therefore DEC SoftWindows
cannot support hardware handshaking; you should use
XON/XOFF software handshaking instead.

• RI (Ring Indicator)— The RI modem input signal cannot be
detected; the software forces it off.

• Input Errors— The occurrence of input overrun and framing
errors in the hardware or an input break condition cannot be
detected.
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Recommendations
for Using Serial
Ports

The following recommendations apply if you are either choosing
a package to run under DEC SoftWindows on the OpenVMS
workstation or developing software that uses the serial ports for
communication.

• You should normally use 4800 baud or lower. Higher speeds
are likely to be less reliable.

• The packet size should be kept small; 512 to 1024 bytes is a
suitable size.

• Interrupt driven, rather than polled data transfer is
preferable. When DEC SoftWindows receives data from
an external source with XON/XOFF data flow control, the
program running on DEC SoftWindows may have problems.
This is due to host buffering of input data preventing the
program from responding quickly enough to XOFF signals.
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5
Networking

This chapter describes the SoftNode networking features built
into DEC SoftWindows and describes how to install the following
network packages:

• Novell Netware

• Microsoft LAN Manager

• Banyan Vines

• Novell LAN Manager for DOS

The chapter also discusses using TCP/IP and Ethernet frame
types.

What is SoftNode?

SoftNode is the name given to the portion of DEC SoftWindows
that implements networking functionality. This module makes it
possible to run standard PC networking software such as Novell
NetWare and Microsoft LAN Manager on DEC SoftWindows.

In technical terms, SoftNode is an ODI-compliant network driver.
This means that it effectively emulates a network card, the
interface to which is Novell’s ODI standard.

Compatibility

Since SoftNode is an ODI driver, it is theoretically compatible
with any ODI-compliant network software. It is also compatible
with any NDIS-compliant software, using Novell’s NDIS-to-ODI
converter program, ODINSUP. However, due to the limitations of
some manufacturers’ network facilities, it is impossible to provide
identical functionality on all ports.
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TCP/IP
Connectivity

SoftNode attempts to handle TCP/IP packets exactly like other
packets. Where possible, SoftNode is compatible with any ODI or
NDIS-based TCP/IP package, such as Novell LAN Workplace for
DOS or Sun PCNFS. Unfortunately, not all versions of Unix can
deal with TCP/IP packets at a low enough level. To provide some
TCP/IP connectivity for these ports, Insignia produced a TSR
program called ISTCPIP, which implements the API for Novell
LAN Workplace for DOS applications.

Supported
Network
Software

Table 5–1 lists the network software packages with which
SoftNode has been tested successfully. Note that the table
does not include a complete list of ODI- and NDIS-compliant
applications.

Table 5–1 Supported Network Software

Ports Network Software Packages

All Ports support Novell NetWare 3.x and 4.x
Banyan Vines

OpenVMS Alpha
AXP,
Sun (SunOS and
Solaris), and
SGI(Irix)

support Microsoft LAN manager
Novell LAN Workplace for DOS
Sun PCNFS
FTP PC/TCP
Wollongong Pathway

IBM RS/6000 (AIX) supports Microsoft LAN manager 2.x
Novell LAN Workplace for DOS1

HP PA-RISC (HP-
UX)

supports Novell LAN Workplace for DOS1

1The relevant operating system cannot support TCP/IP directly. Novell LAN Workplace
TCP/IP support is provided by the Insignia ISTCPIP program.
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Configuring SoftNode

SoftNode is an ODI driver, so its configuration is driven entirely
from the file ENET.CFG, which is normally located in the root
directory of the boot drive. This file is the master configuration
file for the ODI system and contains sections which relate to
different parts of the system.

For example, the Link Support section contains configuration
information for the Link Support Layer, which handles
communication between the component parts of the system. The
Link Driver section contains configuration information pertaining
to the driver itself, specifying the frame types and protocols which
are to be used. A sample Link Driver section follows:

Link Driver ETHERSPC
Frame Ethernet_II
Frame Ethernet_802.3
Frame Ethernet_802.2
Frame Ethernet_SNAP
Protocol IPX 8137 Ethernet_II

The Frame lines in this Link Driver section allow all four
Ethernet frame types to be used with the driver. This means
that the driver can transmit and receive frames of the four
most common hardware packets. Note that the order of the
lines is significant. Insignia recommends that all SoftNode Link
Driver sections include these four lines. A configuration like this
prevents Frame and Protocol mismatches from occurring and
makes configuring for both ODI and NDIS identical.

A Link Driver section set up to transmit and receive Banyan
Vines packets would resemble the following:

Link Driver ETHERSPC
Frame Ethernet_II
Frame Ethernet_802.3
Frame Ethernet_802.2
Frame Ethernet_SNAP
Protocol Vines BAD Ethernet_II

The Protocol line in this Link Driver section enables the driver to
transmit and receive Ethernet II format frames with a protocol
IDF of 8137 hex. This protocol ID is the one assigned for the IPX
protocol; the IPX in the Protocol line is merely descriptive. The
IPX protocol is unique because it can be configured to run over
any frame type, most other protocols run only over a single static
frame type.

Table 5–2 lists protocols used by the currently tested applications,
their protocol IDs, and the frame types over which they can run:

5–3



Table 5–2 Protocols Used by Applications

Application Protocol Protocol ID Frame Type

NetWare IPX 0 Ethernet_802.3

NetWare IPX E0 Ethernet_802.2

NetWare IPX 8137 Ethernet_SNAP

NetWare IPX 8137 Ethernet_II

TCP/IP IP 800 Ethernet_II

TCP/IP ARP 806 Ethernet_II

Vines Vines BAD Ethernet_II

LAN
Manager

SMB FO Ethernet_802.2

Table 5–3 lists the network packages that run on the OSF/1 and
OpenVMS AXP operating systems.

Table 5–3 Network Packages on OSF/1 and OpenVMS Systems

DOS OSF/1 OpenVMS

DECnet1 Yes2 Yes2

IPX Yes Yes

TCP/IP Yes Yes, if not using UCX.

NETBIOS Yes Yes

LANMAN Yes Yes

Vines Yes Yes

Winsockets Yes Yes, if not using UCX.

1You cannot run Pathworks under DOS over DECnet if you are running DECnet with
either OSF/1 or OpenVMS. You can, however, run Pathworks over NetBEUEI or TCP.
2Unless DECnet is already in use on that system. This is likely with OpenVMS.
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Using Novell NetWare

A NetWare 3.11 client is standard on every hard disk file created
by DEC SoftWindows. Therefore, since NetWare runs over the
IPX protocol, installation first involves matching IPX frame
types with those configured on the server and then loading the
appropriate software.

To Load the
NetWare Client
Software

To load the NetWare Client software and connect to the NetWare
server, type the following commands:

C:\> LSL Return

C:\> ETHERSPC Return

C:\> IPXODI Return

C:\> NETX Return

The server’s login directory should appear on the drive letter
immediately following that specified in the LASTDRIVE line in
your CONFIG.SYS file (usually L:).

Then type the following commands:

C:\> L Return

C:\> LOGIN Return

After entering your login name and password correctly, you have
full access to the server.

Example:

The following example compiles the kernel using the packet filter
option. The frame type used is ETHERNET_II.

Sample net.cfg:

; Lines beginning with a ; are comments.
;
Link Support
MemPool 4096

Link Driver EtherSPC
; Default frame type. Don’t need to set protocol number.
; Frame ETHERNET_802.3
; Protocol IPX 0 ETHERNET_802.3
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; Frame used by NetWare 286 after running ECONFIG
Frame ETHERNET_II
Protocol IPX 8137 ETHERNET_II
;
; Netware386 packet type 3
; Frame ETHERNET_SNAP
; Protocol IPX 8137 ETHERNET_SNAP
;
; Netware386 packet type 4
; Frame ETHERNET_802.2
; Protocol IPX e0 ETHERNET_802.2
;
; TCPIP configuration
; Frame ETHERNET_II
Protocol ARP 806 ETHERNET_II
Protocol IP 800 ETHERNET_II
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Using Microsoft LAN Manager

LAN Manager client software must be installed from the standard
distribution floppy disks. This section describes how to install
the LAN Manager. The description takes into account that LAN
Manager runs over NDIS.

Step 1:
Editing the
CONFIG.SYS
File

You need to edit the CONFIG.SYS file created by the DEC
SoftWindows hard disk creation facility to enable the hard disk to
communicate properly with LAN Manager:

• Because the LAN Manager MS–DOS redirector,
PROTMAN.DOS, conflicts with the DEC SoftWindows
FSA redirector, HOST.SYS, you must remove the line
that loads the HOST.SYS file before installing LAN manager.
Remove or comment out the following line in the CONFIG.SYS
file:

DEVICE=C:\INSIGNIA\HOST.SYS

Then restore FSA functionality by adding the following line to
the AUTOEXEC.BAT file:

DEVLOD C:\INSIGNIA\HOST.SYS

• To give LAN Manager more space to assign drive letters,
you must alter the LASTDRIVE value by changing the value
assigned to LASTDRIVE in the CONFIG.SYS file, for example:

LASTDRIVE=Z

Step 2:
Installing LAN
Manager

Install LAN Manager from the distribution floppies. When the
installation procedure asks for the name of an Ethernet driver,
pick any on the list. The driver you select will be replaced by the
DEC SoftWindows ODI driver. Insignia recommends that you
do not allow the procedure to modify your AUTOEXEC.BAT and
CONFIG.SYS files, which would cause errors during the next
boot.

Step 3:
Configuring
the Protocol
Manager

To correctly configure the Protocol Manager, ensure that the
CONFIG.SYS file includes the following line :

DEVICE=C:\LANMAN.DOS\DRIVERS\PROTMAN.DOS
/I:C:\LANMAN.DOS

The directory LANMAN.DOS is the default installation directory
for LAN manager files. If you ask the installation procedure to
install to a different directory, you must replace LANMAN.DOS
with the name of this directory as shown in the example above.

To inform LAN Manager that you will use the DEC SoftWindows
network driver rather than the one specified in the installation
procedure, change the BINDINGS line in the [NETBEUI_XIF]
section of the PROTOCOL.INI file in the installation directory to:
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BINDINGS = ETHERSPC

Note that the name of the of this section may change if you intend
to run LAN Manager over a protocol other than NetBEUI.

Step 4:
Rebooting DEC
SoftWindows

At this point, reboot DEC SoftWindows to implement the changes
to the CONFIG.SYS file that you have just made.

Step 5:
Configuring
SoftNode

Normally LAN Manager runs over the NetBEUI protocol. This
in turn runs over the lower level SMB protocol, which is based
on Ethernet 802.2 frames with a protocol ID of F0 (hex). Thus,
using the information given earlier, the LinkDriver section of the
NET.CFG file should be:

Link Driver EtherSPC
Frame Ethernet_II
Frame Ethernet_802.3
Frame Ethernet_802.2
Frame Ethernet_SNAP
Protocol SMB F0 Ethernet_802.2

If you wish to run LAN Manager over a different protocol, for
example, TCP/IP, refer to Configuring SoftNode, earlier in this
chapter, for appropriate frame types and protocol IDs.

Step 6:
Loading the
ODI System

To load the component parts of the ODI system, including the
Link Support Layer, ODI driver, and NDIS-to-ODI converter, type
the following lines.

LSL Return

ETHERSPC Return

ODINSUP Return

Step 7:
Loading LAN
Manager Client

The loading order of the various programs that comprise the
LAN Manager client can change between different versions of the
client. Insignia recommends that you consult the LAN Manager
documentation, or the modified AUTOEXEC.BAT file that was
kept aside after the installation, for exact details.

For LAN Manager client V2.1, the command sequence follows:

NET START WORKSTATION
LOAD NETBEUI

Step 8:
Accessing the
Network

Log on to the network and access LAN Manager volumes using
the following standard commands:

NET LOGON user
NET USE drive letter: \\server\volume
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Using Banyan Vines

Load Banyan Vines from the floppy disks onto the C drive in
directory BAN50. Like LAN Manager, Banyan Vines runs over
NDIS. This section describes the procedures for installing Banyan
Vines.

Step 1:
Changing
NET.CFG

Change \novell\net.cfg to include the following lines:

Link Driver ETHERSPC
Frame ETHERNET_802.3
Frame ETHERNET_802.2
Frame ETHERNET_II
Frame ETHERNET_SNAP
Protocol BANYAN BAD ETHERNET_II

Protocol ODINSUP
Bind ETHERSPC

Step 2:
Changing
CONFIG.SYS

If necessary change the CONFIG.SYS file to ensure that the
following line is included:

device=c:\ban50\protman.dos /i:c:\ban50

Step 3:
Creating a
PROTOCOL.INI
File

Create a PROTOCOL.INI file in the directory BAN50 as follows:

[protocol manager]
drivername=PROTMAN$

[VINES_XIF]
DRIVERNAME=NDISBAN$
BINDINGS=ETHERSPC

Step 4:
Loading the
ODI System

Start NOVEL using the following commands:

LSL Return

ETHERSPC Return

ODINSUP Return

Step 5:
Running the
PCCONFIG
Utility

Run PCCONFIG in BAN50 to configure the interface as follows:

• Select "Network Card Settings".

• Choose "NDIS Ethernet".

• Set the INTERRUPT to 10 and BINDING to ETHERSPC.

• Press F10 twice to return to the main menu.

• Choose option 2, "Login Environment Settings".

• Choose "NDIS Ethernet".

• Press F10 until PCCONFIG saves the changes and returns to
DOS.

Now restart DEC SoftWindows.
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Step 6:
Starting Vines

At the C:\> prompt, enter the following commands to start
Banyan Vines:

C:\> LSL Return

C:\> ETHERSPC Return

C:\> ODINSUP Return

C:\> CD \BAN50 Return

C:\> BAN /NC Return

(Ignore the "no network interface enabled".)

C:\> NDISBAN Return

C:\> NETBIND Return

C:\> ARSWAIT Return

C:\> REDIRALL Return

Step 7:
Accessing the
Network

Login to the server using the following command:

Z:LOGIN Return

5–10



Using Novell LAN Workplace for DOS

Novell LAN Workplace is an industry standard PC
implementation of TCP/IP based on ODI. Therefore, the
default installation procedure should suffice to set up DEC
SoftWindows.

Step 1: Install
LAN Workplace

The LAN Workplace installation procedure asks several questions
to correctly configure the workstation. Make sure that you have
the following information before you begin the installation. Ask
your system administrator for information about your network.

• A unique IP number (not the IP number of the host
workstation)

• Your network’s subnet mask

• The IP number of your DNS server(s)

• The IP numbers of your IP gateways and routers

• Whether or not your network uses the ARP protocol to resolve
names

• Whether or not your workstation will remote boot from
another machine

Step 2:
Configure
SoftNode

After installation, verify that the correct Frame and Protocol
lines for the IP and ARP protocols are present in the Link Driver
section of the NET.CFG file.

The following section should contain at least the following:

Link Driver ETHERSPC
Frame Ethernet_II
Protocol IP 800 Ethernet_II
Protocol ARP 806 Ethernet_II

Step 3: Load
the ODI System

Load the ODI system, including the Link Support Layer and the
ODI driver, by typing:

LSL Return

ETHERSPC Return

Step 4: Load
the TCP/IP
Stack

Load the LAN Workplace TCP/IP module by typing:

TCPIP Return

When loaded successfully, this program displays its configuration,
which it reads from the NET.CFG file. Check that the details
are correct and that the protocol is registered to run over the
Ethernet II frame type.
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Step 5:
Use TCP/IP
Applications

You should be able to use the MS–DOS and Windows applications
provided with the LAN Workplace package. For example, type:

PING hostname Return

FTP hostname Return

TNVT220 hostname Return

Additional Information

Using Other
Versions of
TCP/IP

There are several other implementations of TCP/IP for the
PC, most of which have been tested successfully with DEC
SoftWindows. Although these packages have different installation
procedures, basically they all send and receive the same packets.
Since the actual SoftNode Configuration of these packages is
identical, IP and ARP protocols over the Ethernet II frame type
should be enabled.

Some packages require that an IRQ number be set for the driver.
If an installation procedure asks for this information, use IRQ
number 10 (decimal).

Ethernet Frame
Types

Ethernet II

This is the frame type normally used for TCP/IP packets. It can
also be configured for IPX packets.

You can distinguish this frame type from the 802.2 and 802.3
frame types because the the 2 byte field following the hardware
addresses must be greater than the maximum Ethernet packet
size (1514 decimal). The format follows:

• Destination Ethernet Hardware Address

• Source Ethernet Hardware Address

• Protocol Number (for example, 8137 for IPX)

Ethernet 802.2

This is also known as the Ethernet 802.3 with 802.2 envelope
frame type. It is the usual format used by SMB packets, however
it can be used to transport IPX packets. With the advent of
NetWare 4.X, this is the new default frame type for ODI drivers.

You can distinguish this frame type from the Ethernet II frame
type because the 2 byte field following the hardware addresses
must be less than or equal to the maximum Ethernet packet size
(1514 decimal). The format follows:

• Destination Ethernet Hardware Address

• Source Ethernet Hardware Address

• Packet Length (0-1514 bytes)

5–12



• Destination SAP (such as E0 for IPX)

• Source SAP (such as E0 for IPX)

• Control Byte

Ethernet 802.3

This is the original frame type for IPX, developed by Novell but
not recognized as an official frame type by the IEEE. This frame
type requires the IPX checksum field be hardwired to ff:ff hex
to be recognized so it cannot be used with IPX checksumming
enabled. Therefore, it is being phased out by Novell. The format
follows:

• Destination Ethernet Hardware Address

• Source Ethernet Hardware Address

• Packet Length (0-1514 bytes)

• Checksum of IPX Packet Header (ff:ff hex)

Ethernet SNAP

This is the frame type normally used by AppleTalk packets,
however it can be used to transport IPX packets. You can
distinguish this frame type from the Ethernet 802.2 frame type
by the distinctive SSAP, DSAP and Control values in its 802.2
headers. The format follows:

• Destination Ethernet Hardware Address

• Source Ethernet Hardware Address

• Packet Length (0-1514 bytes)

• Destination SAP of AA hex

• Source SAP of AA hex

• Contrtol Byte of 03 hex

• Protocol Number (such as 0:0:0:81:37 hex for IPX)
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6
Setting up Windows

This chapter describes how to set up the Windows screen, how to
install and use Windows applications, and how to install printer
drivers, keyboard drivers, and fonts.

For more detailed information about Microsoft Windows refer to
the Microsoft Windows User’s Guide and User’s Reference.
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Setting Up Memory

To run Windows you need at least 2 Mbyte of Main memory.
The performance of Windows improves with additional Extended
memory up to a certain point. Windows does not benefit from
Expanded memory, however, so Digital recommends that you set
it to 0 Mbyte.

Note

Do not allocate excessive memory. Excessive memory
reduces the performance of your workstation and other
OpenVMS programs. The default amount of memory, 4
Mbyte, is the recommended setting, but you may wish to
experiment with different settings for better results.

For more information about PC memory, refer to Setting Up
Memory, Chapter 4.

To Change the
PC Memory

To change the PC memory, use the following procedure:

• On the Options menu choose Memory.
The dialog box shows the current size set for each type of PC
memory, Main (Extended), and Expanded, and allows you to
change it.

• Select the amount of Extended memory to allocate using the
Main slider.

• Click OK to confirm the changes.

If you have changed the memory settings, a dialog box will be
displayed to allow you to restart DEC SoftWindows.
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Installing Printer Drivers, Keyboard Drivers, and Fonts

This section describes how to use the Windows Control Panel to
select a different printer driver, how to install additional printer
drivers or fonts, and how to change the keyboard layout. DEC
SoftWindows comes with a selection of printer drivers, all the
standard Windows fonts already installed, and the keyboard set
up to use a US keyboard layout.

To Select a
Printer Driver

To select a printer driver, use the following procedure:

• Double-click on the Control Panel Icon in the Main
Window.

• Double-click on Printers in the Control Panel window.
The Printers dialog box appears, showing the currently
selected default printer, and the list of installed printers.

• Choose the printer you want to use in the Installed Printers
list, and choose Set As Default Printer.
DEC SoftWindows has several printer drivers that you can
install.

• If the printer you want to use is not installed, choose Add to
list the available printer drivers in the following dialog box:
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• If your printer driver is on the list, select the printer driver
you want to add and choose Install.
If necessary, the following dialog box appears to allow you to
locate the printer driver:

• Enter G:\ and choose OK. Note that MS-Windows is supplied
on the G: drive.

• Choose Close to close the Printers dialog box.

To Change the
Keyboard

To change the keyboard layout, use the following procedure:

• Double-click International in the Control Panel window.
The International dialog box appears.

• Choose the down arrow to open the Keyboard Layout
drop-down list box, and select the layout you require.
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• Choose OK to use the new layout.

To Add Fonts To add fonts, use the following procedure:

• Double-click Fonts in the Control Panel window:
The Fonts dialog box lists the fonts installed for use by
Windows.

• Choose Add to install additional fonts.
The Add Fonts dialog box appears.

• Open the Drives list, and select the G: drive.
The List of Fonts box shows the available fonts.

• Select the fonts you want to add, and choose OK.

• Choose Close to exit from the Fonts dialog box.
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Installing and Running Windows Applications

Most Windows applications are installed using an installer
program typically called SETUP or INSTALL. With DEC
SoftWindows you can install Windows applications just as you
would on a PC.

To Install a
Windows
Application

To install a Windows application, use the following procedure:

• Check that the floppy disk drive is set up as A:. Refer to
Using Floppy Disks, Chapter 4.

• From the Program Manager File menu, choose Run.

• Follow the instructions for your application. A typical example
follows:

• Type A:\SETUP, for example, and choose OK.

As the installation proceeds, a series of dialog boxes similar to
the one shown below prompts you for information needed for the
installation.
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To Run a
Windows
Application

To run a Windows application, use the following procedure:

• Double-click the application icon in the appropriate program
group.
For example, to run Solitaire, supplied with Windows, proceed
as follows:

• Double-click the Games program group icon, to open it:

• Double-click the Solitaire icon, to run Solitaire.
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7
Using MS–DOS

This chapter describes the MS–DOS operating system and
explains how to take advantage of the most useful MS–DOS
features.

About MS–DOS

DEC SoftWindows includes MS–DOS version 6.21. As with earlier
versions of MS–DOS, you give commands to the computer by
typing instructions at the MS–DOS C:\> prompt.

Using the
MS–DOS Editor

MS–DOS 6.21 includes the MS–DOS Editor, a simple screen
editor with which you create, edit, and print plain text files.
The editor includes menu commands and you can also edit text
using the mouse. The editor is particularly useful for editing
MS–DOS batch programs and files such as AUTOEXEC.BAT and
CONFIG.SYS.

MS–DOS 6.21 also includes EDLIN, the less powerful line editor
provided with earlier versions of MS–DOS.

To Run the
MS–DOS
Editor from
the MS–DOS
Prompt

To run the MS–DOS Editor:

• Type:

EDIT filename Return

where filename is the name of the file you want to edit. Omit
the filename to create a new file.
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For example, to edit the AUTOEXEC.BAT startup file, type:

EDIT AUTOEXEC.BAT Return

Figure 7–1 shows the file as it appears in the MS–DOS Editor
window.

Figure 7–1 MS–DOS Editor Window
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To Edit the File To edit the file:

• Position the cursor either by using the arrow keys or by
clicking with the mouse.

• Type to insert text at the cursor.

To Cut, Copy,
and Paste Text

To cut, copy, and paste text:

• Drag to select the text you want to cut or copy.

• Use the Cut, Copy, Paste, and Clear functions from the
MS–DOS Editor’s Edit menu in exactly the same way as you
would use the equivalent functions in X Windows applications.

To Delete Text To delete text:

• Drag to select the text you want to delete.

• Either press Delete or type the text you want to replace it.

To Exit from
the MS–DOS
Editor

To exit from the MS–DOS Editor:

• Choose Exit from the Editor’s File menu.
The dialog box shown below prompts you to save the file
before exiting if you have made any changes to it.

• Either click Yes or press Return to save the changes and exit
from the MS–DOS Editor.
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Using MS–DOS Commands

With DEC SoftWindows, you enter MS–DOS commands at the
MS–DOS prompt as you would on a real PC. This section briefly
describes the following useful MS–DOS commands:

Getting Help
CD
COPY
DEL
DIR
FORMAT
HELP
MKDIR (MD)
PRINT
RMDIR (RD)
TYPE
XCOPY

Refer to an MS–DOS reference guide for more detailed
information.

In the following command descriptions, italics indicate command
arguments and square brackets indicate optional arguments.

Note that MS–DOS is not case-sensitive—it treats upper- and
lower-case characters in the same way.

Getting Help To display help about any command, type:

command /?

CD Changes the current directory.

Syntax

CD [path]directory

Example

To change your current directory to C:\LOTUS, type:

CD C:\LOTUS Return

COPY Copies one or more files between two directories.

Syntax

COPY [drive:][path]file [drive:][path]file

Example

To copy a file named BUDGET.WK1 from the LOTUS directory on
your C: drive to the D: drive, type:

COPY C:\LOTUS\BUDGET.WK1 D:\BUDGET.WK1 Return
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DEL Deletes specified files.

Syntax

DEL [drive:][path]file

Example

To delete the file named \WP\REPORT.OLD on the D: drive,
type:

DEL D:\WP\REPORT.OLD Return

DIR Lists the files in a directory.

Syntax

DIR [drive:][path][/W]

The /W (keep) option displays the files in columns.

Example

To list the files on your D: drive in the WP subdirectory in wide
format, type:

DIR D:\WP/W Return

FORMAT Formats a disk.

Syntax

FORMAT [drive:] [/option]

where option is either F:720, F:1.44, or F:2.88 as described in the
following table:

To format Give this command

3 1/2" double density FORMAT A: /F:720 Return

3 1/2" high density FORMAT A: /F:1.44 Return

3 1/2" extended density FORMAT A: /F:2.88 Return

Note that you should only format double-density disks in the 720
Kbyte format, high-density disks in the 1.4 Mbyte format and
extended-density in the 2.88 Mbyte format.

Note

You must use the VMS command INITIALIZE on a floppy
disk before you can use the MS–DOS command to format
it. For details, see To Format a Floppy Disk, Chapter 2.

A drive set up as a DEC SoftWindows FSA drive cannot be
formatted.
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HELP Gives help about using an MS–DOS command.

Syntax

HELP [command]

where command is the long or short form of the command.

Example

To get help about FORMAT command:

HELP FORMAT Return

MKDIR (MD) Makes a subdirectory.

Syntax

MKDIR [drive:][path]directory

Example

To make a directory named PCAPPS on your D: drive, type:

MKDIR D:\PCAPPS Return

PRINT Prints a text file to the printer.

Syntax

PRINT [drive:][path]file

Example

To print the file named TEXT.OUT from the WP subdirectory on
your D: drive, type:

PRINT D:\WP\TEXT.OUT Return

Note that after typing in a PRINT command, you may see the
message:

Enter the name of the list device [prn:]

Respond by pressing Return

RMDIR (RD) Removes an empty directory.

Syntax

RMDIR [drive:][path]directory

Example

To remove the empty subdirectory named TEMP from your D:
drive, type:

RMDIR D:\TEMP Return
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TYPE Displays the contents of a text file on the screen.

Syntax

TYPE [drive:][path]file

Example

To display the contents of the file TEXT.OUT from the WP
subdirectory on your D: drive, type:

TYPE D:\WP\TEXT.OUT Return

XCOPY Copies files and directories, including their subdirectories.

Syntax

XCOPY [drive:][path]file [drive:][path] /S

Example

To copy all the files and directories from your C: drive to your D:
drive, type:

XCOPY C:\*.* D: \S Return
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Installing MS–DOS Applications

MS–DOS software is typically supplied on one or more floppy
disks. To install the program, copy the files from these disks
to your PC hard disk. For specific instructions, refer to the
application’s manual.

To simplify the installation process, most PC programs provide a
batch file which automatically copies the files. This batch file is
typically called SETUP.BAT or INSTALL.BAT. Run it by typing
SETUP or INSTALL at the MS–DOS prompt.

To Install from
3 1\2" Disks

The simplest way to install PC software (if you have a floppy
disk drive available) is to install directly from 3 1\2" installation
disks.

A typical sequence follows:

• Set up the workstation’s floppy disk drive as drive A: or B:;
refer to Setting Up Floppy Disk Drives, Chapter 4. A: or B:
appears in the DEC SoftWindows status bar, indicating that
the drive is available to DEC SoftWindows. Now you can
access the disk from DEC SoftWindows.

• Follow the instructions supplied with the software. For
example, you may be instructed to type:

A:\SETUP Return

If at any stage in the installation you need to change disks,
refer to To Eject a Floppy Disk, Chapter 2. MS–DOS software
is typically supplied on one or more floppy disks. To install the
program, copy the files from these disks to your PC hard disk.

Installing From
an FSA Drive

Instead of installing directly from 3 1\2" disks, you can copy
the software from a PC to a directory on your workstation, over
a network or a serial connection. Attach the directory to DEC
SoftWindows as an FSA drive so that you can access the files
from DEC SoftWindows, as described in Setting Up FSA Drives,
Chapter 4. Then install from the files in this directory.

Note

Some installer programs assume you are installing from
floppy disk. The files may not work correctly if you first
copy them to a hard disk, then install from the hard disk.
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Where to Install The installation program typically gives you the option of where
to install the files it is copying from the installation disks. You
have the following options:

Install here If

Drive C: or D: DEC
SoftWindows hard
disk file

You are sure that the files you are
installing will fit on your DEC SoftWindows
hard disk file, and that you do not need to
access the files using other OpenVMS
programs.

Drive E: to K:
DEC SoftWindows
FSA drive; refer
to Setting Up FSA
Drives, Chapter 4.

You are not sure how much space the
software you are installing needs, and you
may need to access the files using other
OpenVMS programs.

Note

Some PC application installer programs will only install
onto a hard disk. Some programs will assume that
drives E: to Z: are a PC network, and install additional
networking software if you specify these drives.

Disk Space
Requirements

Before installing onto the hard disk, check the disk space
requirements specified in the application manual, and check the
available hard disk space. For example, if you are installing to
drive C:, type:

CHKDSK Return

at the C:\> prompt in DEC SoftWindows.

Note that 1048576 bytes = 1 Mbyte.

If you do not have enough space to install the application, refer to
Setting Up Drives, Chapter 4, for details on how to create a larger
hard disk.

The DEC SoftWindows hard disk files cannot be expanded
because they emulate real PC hard disks which cannot change
in size. To increase the size of the C: or D: drive, create a new
and larger D: hard disk file, then copy your information from the
old file to the new one using the XCOPY command; refer to the
section XCOPY, earlier in this chapter, or Creating a New Hard
Disk, Chapter 2.
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8
DEC SoftWindows Configuration

This chapter describes the DEC SoftWindows system configuration
file SWINCONFIG.INI and the MS–DOS configuration files
CONFIG.SYS and AUTOEXEC.BAT.

SWINCONFIG.INI Configuration File

DEC SoftWindows configuration settings are stored in a
configuration file named SWINCONFIG.INI in your home
directory. They determine the settings in each of the Options
menu dialog boxes. Any changes you make in these dialog boxes
are saved in the configuration file when you exit from DEC
SoftWindows with Save Configuration Changes checked.

You can also edit your DEC SoftWindows configuration file using
an OpenVMS text editor such as EDT.

The System
Defaults

The system configuration file SWINCONFIG.INI determines the
initial DEC SoftWindows configuration. The file is installed into
the DEC SoftWindows directory specified by the environment
variable SOFTWIN$HOME. The system administrator can
edit the system configuration file to set up a different initial
configuration of DEC SoftWindows.

The system configuration file also contains entries that determine
the default values for the LPT and COM port settings, the
maximum hard disk drive and memory sizes, and the initial size
of the Windows desktop.

Figure 8–1 is a complete listing of the SWINCONFIG.INI system
configuration file.
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Figure 8–1 SWINCONFIG.INI System Configuration File

DRIVE_C_FILE_NAME SOFTWIN$HOME:MS-WIN-31.hdf
DRIVE_D_FILE_NAME
DRIVE_CDROM_DEVICE_NAME
DRIVE_FSA_ROOT_DIRECTORY SYS$LOGIN
DRIVE_FLOPPY_A_DEVICE_NAME
DRIVE_FLOPPY_B_DEVICE_NAME
DISPLAY_GRAPHICS_ADAPTOR VGA
DISPLAY_SIZE 1.0
DISPLAY_MSWIN_WIDTH 640
DISPLAY_MSWIN_HEIGHT 480
DISPLAY_MSWIN_COLOURS 16
MEMORY_EXTENDED_SIZE 4
MEMORY_EXPANDED_SIZE 0
MEMORY_EXPANDED_BACK_FILL No
LPT_PORT_1_TYPE
LPT_PORT_2_TYPE
LPT_PORT_3_TYPE
LPT_PORT_1
LPT_PORT_2
LPT_PORT_3
COM_PORT_1_TYPE
COM_PORT_2_TYPE
COM_PORT_3_TYPE
COM_PORT_4_TYPE
COM_PORT_1
COM_PORT_2
COM_PORT_3
COM_PORT_4
SOUND No
AUTO_FREEZE No
AUTO_FLUSH Yes
FPU_EMULATION Yes
AUTO_FLUSH_DELAY 50
KEYBOARD_MAP_FILE_NAME SOFTWIN$HOME:[keyboard]DECus401.kbd
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MS–DOS Configuration

The contents of the files AUTOEXEC.BAT (Figure 8–2)
and CONFIG.SYS (Figure 8–3) determine the MS–DOS
configuration.

Figure 8–2 AUTOEXEC.BAT Configuration File

@loadhigh C:\DOS\SHARE.EXE /l:500 /f:5100
@Echo off
Prompt $p$g
Path C:\WINDOWS;C:\DOS;C:\Insignia;c:\novell
C:\INSIGNIA\FSADrive e:
C:\INSIGNIA\Mouse
Mode COM1:9600,n,8,1
Net Use G: SOFTWIN$HOME:[windows]
Net Use H: SYS$LOGIN
Ver
Set TEMP=C:\DOS
C:\INSIGNIA\DEVLOD C:\INSIGNIA\CDROM.SYS
mscdex /d:cdrom$$$ /l:f /e /v
Echo Type ETHER and press ENTER to run SoftNode
Echo Type WIN and press ENTER to start Windows

Figure 8–3 CONFIG.SYS Configuration File

DEVICE=C:\DOS\SETVER.EXE
DEVICE=C:\DOS\HIMEM.SYS
DOS=HIGH,UMB
devicehigh=c:\insignia\cdrom.sys
FILES=30

DEVICE=C:\INSIGNIA\EM_DRVR.SYS
DEVICE=C:\INSIGNIA\HOST.SYS
LASTDRIVE=K

BUFFERS=15
STACKS=9,256
FCBS=20,20
DEVICE=C:\DOS\DISPLAY.SYS CON=(EGA,437,4)
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9
Displaying Remotely

This chapter provides information about installing and setting up
DEC SoftWindows on a second workstation.

To make DEC SoftWindows available to additional workstations,
either install DEC SoftWindows on each workstation or set up
DEC SoftWindows to display on a remote workstation. In either
case, you need a license for each copy of DEC SoftWindows you
want to run concurrently.

To Display DEC SoftWindows on a Remote Workstation

The procedure described in this section uses the following terms:

Term Meaning

Local workstation The system actually running the
DEC SoftWindows software

Remote workstation The system displaying DEC
SoftWindows remotely. It can be
either a workstation or some other X
Windows device.

To display DEC SoftWindows on a remote workstation, use the
following procedure:

• Make sure that the remote workstation has the SoftWindows
fonts set up. The procedures for making the fonts available
depend on the type of remote workstation or device.

• From the Session Manager Options menu on the remote
workstation, select Security. In the Security dialog box,
enter the user name, node, and transport (DECnet) of the
local workstation from which DEC SoftWindows will run.
This gives DEC SoftWindows permission to run on the remote
workstation.

• From the remote workstation, use the SET HOST command
to log onto the local workstation and account entered in the
Security dialog box.

9–1



• Enter the following command to tell DEC SoftWindows which
node to display on:

SET DISPLAY/CREATE/NODE=node

where node is the node name of the remote workstation.

• Enter the command:

softwindows

DEC SoftWindows starts up on the remote workstation if the
preceding steps have been successful. Refer to Using Windows,
Chapter 2.

• If the remote workstation is different from the local system,
you may want to tailor the remote environment by editing the
SWINCONFIG.INI configuration file after starting up DEC
SoftWindows at least once. (The configuration file for each
user doesn’t exist until then.) For example, if the keyboard at
the remote workstation is different, it may not work properly
unless you set up the correct keyboard mapping file. You
can tailor all the parameters in the configuration file as
necessary (screen size, colors, disk files, and so on.) Otherwise,
the remote user can tailor the environment using the DEC
SoftWindows Options menu.
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10
Troubleshooting

This chapter suggests solutions to problems that you may
encounter when running PC applications on your workstation
with DEC SoftWindows. It also includes details of the DEC
SoftWindows and MS–DOS error messages, with explanations
and suggested solutions.

Common Problems

The following sections give solutions to the most commonly-
encountered problems when using DEC SoftWindows.

Using Floppy
Disks

How do I format a floppy disk?

Refer to To Format a Floppy Disk, Chapter 2.

Using Hard
Disks

How do I create a new hard disk?

Use the New Drive function on the Disk Drives cascade menu
on the Options menu; refer to Setting Up Drives, Chapter 3.

How do I make a hard disk file larger?

Create a new hard disk file, and then copy the contents of the old
file to the new file; refer to Disk Space Requirements, Chapter 7
or the Release Notes.

How do I share hard disks?

Make the hard disk read-only; more than one user can then
read data from it. To do this, enter the following command in a
terminal window:

SET PROTECTION=(w:RE) filename.hdf

where filename is the name of the hard disk file.

Can I use hard disk files from other versions of DEC
SoftWindows or SoftPC?

You can use the hard disk file from other versions of DEC
SoftWindows as D: but do not use them as drive C: because the
version of Windows and the configuration files are not compatible.
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Using CD-ROM How do I set up a CD-ROM drive?

Refer to Setting Up CD-ROM Drives. Chapter 3.

How do I read an MS–DOS CD-ROM?

Refer to Using CD-ROMs, Chapter 2.

Using Memory How do I change the Extended or Expanded memory
settings for PC applications?

Use the Memory dialog box; refer to Setting Up Memory,
Chapter 3.

Using the
Mouse

The workstation mouse pointer has disappeared

While the mouse is attached for use by MS–DOS applications it is
not available to OpenVMS programs. To detach it, refer to Using
the Mouse, Chapter 2.

Using
Keyboards

How do I set up a foreign keyboard in MS–DOS?

Use the MS–DOS command KEYB.

How do I set up a foreign keyboard in Windows?

Use the Windows International Control Panel; refer to To Change
the Keyboard Layout, Chapter 6.

Using the
Screen

How do I change the size of the DEC SoftWindows screen?

When running MS–DOS you can select between 1.0x, 1.5x, and
2.0x scales in the Display dialog box; refer to To Resize the DEC
Softwindows MS–DOS Window, Chapter 2.

When you are running Windows you can specify any size, up to
the full screen; refer to Using Windows, Chapter 2.

Using Printers How do I set up the COM and LPT ports?
Refer to Printing, Input and Output, Chapter 4.

How can I print from a PC application?

Refer to Printing from PC Applications, Chapter 4.

Printing is not working properly

If you are using the print spooler, try flushing the port to ensure
that all the data has been sent.

Try redirecting print output to a file, then printing the file outside
DEC SoftWindows. Refer to Redirecting to a File and Piping to a
Process, Chapter 4.

How do I set up a printer for Windows?

Use the Windows Printers control panel; refer to To Select a
Printer Driver, Chapter 6.
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Unrecognized <04> in file

Use encapsulated postscript to solve this problem or simply edit
your file to remove the 04 or try different printer options.

Using Serial
Devices

How do I use the serial ports with PC applications?

Refer to To Use Serial Input and Output, Chapter 4.

Converting
Between
MS–DOS and
OpenVMS

How do I convert text documents between DOS and
OpenVMS?

Use the OpenVMS command SOFTWINDOWS/VMS_TO_DOS or
SOFTWINDOWS/DOS_TO_VMS to convert the files. Type

$ HELP SOFTWINDOWS

for more information and refer to Sharing and Using Text Files in
OpenVMS and DOS, Chapter 3.

How can I copy and paste between PC and X Windows
applications?

Use the DEC SoftWindows copy and paste facilities; refer to
Copying and Pasting Text, Chapter 2.

Setting File
Access
Permissions

What are file access permissions?

File access permissions tell a computer system who has access
to files and directories. Each file and directory has a set of
permissions that determines which users can read, write, and
execute the contents of a file. If a system is shared or is part of a
network, other people might have or need access to its files and
directories.

There are four types of permissions that can be applied to files
and directories.

Permission Symbol What it means

Read R Allows users to view or copy a file,
or list files in a directory.

Write W Allows users to create, and edit a
file.

Execute E Allows users to run an executable
file, such as a program or
application, and search a
directory.

Delete D Allows users to delete a file.

Any of the permissions can be assigned to four categories of users:
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User Symbol What it means

System S The System or a person logged
into system.

Owner O The creator of the file (or
directory)

.

Group G The other users in the owners
group.

World W All other users.

How do I check file access permissions?

Check file access permissions using the OpenVMS DIRECTORY
command. In a terminal window, enter:

DIR/PROTECTION filename Return

The response will be similar to this:

C10.SDML;75 (RWED,RWED,RE,)

where the file access permissions are represented by the letters
RWED,RWE,R,R; R is for read, W is for write, E is for execute and D
is for delete. The four sets are for the System, Owner, Group, and
Others, respectively.

How do I change file access permissions?

You can change file access permissions using the OpenVMS SET
PROTECTION command.

To change the permissions, you must be logged in as the owner
or system. If necessary, ask your system administrator to do this.
Then give the SET PROTECTION command with an appropriate
parameter.

The parameter consists of S: (system), O: (owner), G: (group), or
W: (other) followed by the type of access: R (read), W (write), E
(execute) or D (delete). For example, to enable the Owner to write
to a file, use the command:

SET PROTECTION=(O:W) filename

For more information on file access permissions, consult your
OpenVMS reference manuals.

Using
Configuration
Files

Where is my DEC SoftWindows configuration stored?

In the SWINCONFIG.INI file in your home directory; refer to
Softwindows Configuration, Chapter 8.

What determines the configuration of MS–DOS?

The MS–DOS files AUTOEXEC.BAT and CONFIG.SYS. Refer to
MS–DOS Configuration, Chapter 8.
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Using FSA
Drives

I get an error message when I try to use an MS–DOS file on
an FSA drive.

Because MS–DOS was not designed to handle file ownership
and permissions like OpenVMS, MS–DOS uses an assortment
of standard file error messages to indicate that you do not have
permission to read, write to, or execute a given file or directory.

Any of the following messages may indicate that you do not have
access to a particular file or directory, due to the file permissions:

File creation error
File not found
Invalid directory
Invalid path (or file not found)

If one of these messages appears in MS–DOS, and you are certain
that the file or directory exists, you should check the permissions
and ownership, using OpenVMS. Refer to Setting File Access
Permissions, earlier in this chapter.

Alternatively, copy the files to the hard disk C: or D: and try
again.

Using
Networking

The ETHER command does not work

If the following message appears:

Bad command or file name

the batch file ETHER.BAT is not on the path. Either copy
ETHER.BAT into a directory on the path, or amend PATH.

I cannot login

If you try to switch to drive L: to log in, and get the message:

Invalid drive specification

or you run LOGIN.EXE from your hard disk and get the message:

Warning: unexpected error 9(89ff)

The following drive mapping operation could not be completed

this means that the system was unable to map drive letters to
network drives.

Edit the CONFIG.SYS file. It should have an entry of the form:

LASTDRIVE=K

Novell uses drive letters after LASTDRIVE, ie starts with L, etc.

Running PC
Applications

How do I install PC software with DEC SoftWindows?

Refer to Installing MS–DOS Applications, Chapter 7.

How do I give MS–DOS commands?

Type them at the C:\> prompt; refer to Using MS–DOS
commands, Chapter 7.

How can I edit MS–DOS files?
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Use the MS–DOS editor, EDIT; refer to Using the MS–DOS
Editor, Chapter 7. In Windows you can use the Windows
Notepad text editor.

No display is visible in the DEC SoftWindows window

An MS–DOS application may have been started with the wrong
video mode. Change the display type; refer to Setting Up the
Display, Chapter 3.

Application fails to run at all or locks up DEC SoftWindows

The application may be copy protected, and installed on an FSA
drive. Re-install on drive C: or D:.

Alternatively, the application may require Expanded or Extended
memory. Refer to Setting Up Memory, Chapter 3.

Using Windows How do I install new Windows fonts?

Refer to To Add Fonts, Chapter 6.

Windows will not run

Windows needs a minimum of 2 Mbyte of Extended memory to
run, and 4 Mbyte is recommended. Check that this has been set
correctly; refer to Setting Up Memory, Chapter 3.

Windows will not run with a read-only C: drive

Temporarily make it readable and writable. Then in your
AUTOEXEC.BAT file change the line

SET TEMP=C:\DOS

to specify a writable disk. For example:

SET TEMP=H:

I cannot load extra Windows drivers from G:

Check that the FSA drive G: is SOFTWIN$SYSTEM:[windows],
where SOFTWIN$SYSTEM is the DEC SoftWindows installation
(normally :[SoftWindows]), by typing NET USE at the MS–DOS
prompt. Alternatively, before running Windows type:

ASSIGN A=G R

What are the names of the DEC SoftWindows Windows
drivers?

When you run Windows in a window you are not using, one of the
emulated display drivers (VGA, EGA, and so on), and the title
bar changes to DEC SoftWindows Desktop to indicate that
you are using the DEC SoftWindows Windows display and mouse
drivers. These are called DEC SoftWindows Display and DEC
SoftWindows Mouse.
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MS–DOS Errors

These errors may appear in the DEC SoftWindows window:

Error Explanation Suggestion

Not ready error reading
drive A/B Abort, Retry,
Fail

Your floppy disk drive
is not attached to DEC
SoftWindows, or the
specified drive is set to
Empty in the Open Disk
Drives dialog box, or there
is no disk in the drive.

Attach or select the floppy
disk drive, or insert a disk
and retry the command.

Invalid drive specification If you are trying to access
drive D: there is no DEC
SoftWindows hard disk file
selected as drive D:.

Select a file as drive D;
refer to Setting Up Drives,
Chapter 3.

If you are trying to access
an FSA drive, the software
needed to access FSA
drives is not set up
correctly.

Check that CONFIG.SYS
and AUTOEXEC.BAT are set
up correctly; refer to Setting
Up FSA Drives, Chapter 3.

Non System disk DEC SoftWindows is
attempting to boot from
an MS–DOS floppy disk
in drive A: which has
not been initialized as a
startup disk.

Eject the floppy disk from
drive A:.

DOS needs ROM BASIC This means that you have
tried to create a new C
drive but have forgotton to
make it bootable by saying
MAKEBOOT 1.

Refer to Chapter 4.
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DEC SoftWindows FSA Errors

These errors may appear in the DEC SoftWindows window; they
relate to the use of FSA drives:

Error Explanation Suggestion

The host filesystem
directory cannot be found

The FSA directory cannot
be found.

Check that the directory has
not been renamed, moved, or
deleted.

The host filesystem name
must be a directory

An FSA drive has been
given the name of a file.

Only directories can be
specified for FSA drives.

The host filesystem must
have read access

The FSA directory cannot
be read.

Change the directory’s access
permissions.

The x drive is not being
used

You are trying to detach
a drive with NET USE/D
which is not attached.

Check the NET USE
command argument against
drives currently attached.

The x drive is not a
network drive

You are trying to attach a
non-network drive which
is already in use (for
example, drive C:) with a
NET USE command.

Retry the NET USE
command with the correct
drive id.

The x drive is already in
use

You are trying to attach
a network drive (id of E
onwards) with a NET USE
command, but the drive is
already in use.

Retry the NET USE
command with the correct
drive id.

Illegal drive specification The drive specified in an
FSADRIVE or NET USE
command is not valid.

Check that it is a single
letter followed by a colon, in
the range E to LASTDRIVE.
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Networking Errors

These errors may appear in the DEC SoftWindows window; they
relate to the network support software:

Error Explanation Suggestion

WARNING: Error
registering Protocol=IPX,
Frame=ETHERNET_
802.3, PID=X

NET.CFG could not be
found, so default is used.

Create NET.CFG or make
sure the existing one is on
the PATH.

WARNING: Error
registering Protocol=IPX,
Frame=ETHERNET_
802.3, PID=X

The HP port of SoftNode
does not support frame
types SNAP or 802.3.

Alter NET.CFG so that
either 802.2 or ETHERNET
II protocols are specified.

WARNING: Error
registering Protocol=IPX,
Frame=ETHERNET_
SNAP,PID=X

The HP port of SoftNode
does not support frame
types SNAP or 802.3.

Alter NET.CFG so that
either 802.2 or ETHERNET
II protocols are specified.

SHELL-322-21: A network
server could not be found.

A network server could not
be found.

The frame type specified in
NET.CFG is not supported by
the network server. Consult
your network administrator
to find out which types
are supported and amend
NET.CFG accordingly.
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SoftWindows Errors

The following errors, arranged according to the situations in
which they can occur, are displayed in a dialog box.

Error Explanation Suggestion

Starting DEC SoftWindows

The configuration file in
your home directory has
an option with a bad value

There is a problem with
your preferences.

Reset your preferences;
refer to DEC SoftWindows
Configuration, Chapter 8.

The system default
configuration file has a
bad value

The SWINCONFIG.INI
file has an entry with an
invalid value.

Correct the invalid value;
refer to Configuration File,
Chapter 8.

The system default
configuration file has a
duplicate or unrecognized
entry

There is a problem with
the SWINCONFIG.INI
file.

Correct the invalid value;
refer to Configuration File,
Chapter 8.

An installation file
required by DEC
SoftWindows is missing,
execution must terminate.

An ancillary file that DEC
SoftWindows needs is
missing.

Reinstall DEC SoftWindows.

The configuration file
entry shown below has an
invalid value. You may
select Default to replace
it with the system default
value, or type a correct
value and select Continue.

There is a problem with
your preferences such as
a filename misspelled or
nonexistent.

If you cannot correct the
problem with Default
or Continue, click Quit
and reset your preferences;
refer to DEC SoftWindows
Configuration, Chapter 8.

The configuration file entry
shown below is empty. You
may select Default to use
the system default value,
or type a correct value and
select Continue.

There is a problem with
your configuration file.

If you cannot correct the
problem with Default or
Continue, click Quit or
reset your configuration;
refer to DEC SoftWindows
Configuration, Chapter 8.

A configuration file entry
is duplicated or there is
an unrecognized entry.
You may select Default
to ignore this entry, or
type a correct entry name
and value, then select
Continue.

There is a problem with
your configuration file.

If you cannot correct the
problem with Default or
Continue, click Quit or
reset your configuration;
refer to DEC SoftWindows
Configuration, Chapter 8.
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Error Explanation Suggestion

Starting DEC SoftWindows

DEC SoftWindows is not
running with system
permissions. Continuing
will disable floppy and
CDROM support.

The DEC SoftWindows
permissions have
been changed. DEC
SoftWindows needs system
permission.
At root type:

SET PROTECTION =(W:RWE)
_File: SOFTWIN$SYSTEM:SOFTWINDOWS.EXE Return

The DEC SoftWindows
executable is a soft link.
Please execute the actual
DEC SoftWindows.

There is something wrong
with the SoftWin directory.

Check the installation.

Either could not find
or could not ’stat’ the
executable below.

DEC SoftWindows
cannot locate the correct
executable.

Check the installation.

Unable to open the
terminal

DEC SoftWindows could
not locate the keyboard
mapping file.

Check that the keyboard
mapping file is present.

DEC SoftWindows could
not open the font file

DEC SoftWindows could
not access one of the font
files.

Check that the files are
present on the system
where you are displaying.
If you are doing a remote
display, then you must
remotely install and load
the SoftWindows fonts.

DEC SoftWindows Licensing

The license number or
authorization code is
invalid

DEC SoftWindows is not
correctly licensed.

Check the numbers in the
License Manager dialog
box.

All licensed DEC
SoftWindows are
already running. Please
contact your Service
Representative.

You need to upgrade your
DEC SoftWindows license
to cover a larger number
of users, or wait until a
DEC SoftWindows has
shut down.

Try again when a user has
finished. Contact Digital for
license upgrades.

This copy of DEC
SoftWindows is not
licensed, and the demo
period has expired.
You must enter a serial
number and authorization
code to use this product.

The demo period has
expired.

Buy a license. Contact your
Digital Sales Representative.
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Error Explanation Suggestion

Running DEC SoftWindows

The DEC SoftWindows
CPU has encountered an
illegal instruction

The MS–DOS program
you are running has an
illegal instruction in it and
DEC SoftWindows cannot
process it, or you may be
trying to boot from an
invalid floppy.

Make sure you do not have a
floppy disk in the drive while
starting DEC SoftWindows.
Try again; if the error recurs,
reinstall the program. Try
running the program in a
slightly different way. For
other suggestions, refer
to Installing MS–DOS
Applications, Chapter 7.

Internal error in DEC
SoftWindows procedure

This is a rare, but fatal
error and there is no way
to recover.

Reset your preferences;
refer to DEC SoftWindows
Configuration, Chapter 8.
Then restart DEC
SoftWindows and retry the
operations that produced the
error. If the error recurs, call
Digital Service.

DEC SoftWindows does
not support a ROM BASIC

This message indicates
that a program has tried
to access ROM BASIC
and may be caused by
attempting to boot from a
non-bootable disk.

Make the disk bootable.

The file named below is
not accessible to DEC
SoftWindows

DEC SoftWindows cannot
find or access one of its
ancillary files.

A continuous RESET state
has been entered

The CPU is being
continuously rest. A
PC/AT would lock up
in this state, but DEC
SoftWindows will detect
it. It has been caused by
the application you are
running.

If the problem persists,
contact Digital Service.

The date has been set
forward, or the system
frozen for a period. The
PC date may be incorrect.

Self-explanatory.

The date has been set
backward. The PC date
may be incorrect.

Self-explanatory.
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Error Explanation Suggestion

Memory

Failure to allocate the
requested number of
Expanded Memory pages

There is not enough
memory available to
satisfy the requirement
specified.

Reduce the DEC
SoftWindows Expanded
Memory requirement in the
Memory dialog box or free
memory by quitting from
other OpenVMS programs.

The memory resources
needed by DEC
SoftWindows could not be
allocated. Select Continue
to retry.

DEC SoftWindows has
been unable to allocate
the amount of memory it
requires.

Free memory by quitting
from other OpenVMS
programs.

Extended memory has not
been configured.

An attempt has been
made to access Extended
memory beyond 1 Mbyte
when it is set to 1 Mbyte
in the Memory dialog box.

Reset the setting in the
Memory dialog box.

DEC SoftWindows hard disk files

The hard disk is not
writable - check file name
and permissions.

The hard disk cannot be
written to.

Check the file access
permissions; refer to How
Do I Check File Access
Permissions?, earlier in
this chapter.

The hard disk file is not a
valid hard disk because
the disk geometry is
incorrect

The hard disk file does not
have the correct internal
format. Either it is not
a hard disk or another
application has written
into it.

Check the file access
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.

The new hard disk file
could not be created

The attempt to create a
new hard disk file has
failed.

Check the file access
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.

The hard disk has been
mounted read only because
you do not have write
permission for the file.
Check the file permissions
if you need to write to the
disk.

You do not have the
necessary access
permissions to write to
the disk.

Change the file access
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.

Drive C: and Drive D:
cannot be the same file.

You have attempted to
select the same file for C:
and D:.

Choose a different file.
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Error Explanation Suggestion

Floppy disk drives

Floppy drive problem.
DEC SoftWindows cannot
access the floppy device.

DEC SoftWindows cannot
open the floppy device.

Check that the floppy disk
device name is correct; refer
to Using Floppy Disks,
Chapter 2. Check the
privileges and verify that the
user has write permission.

The host computer has
no floppy drive that DEC
SoftWindows can access

DEC SoftWindows cannot
access the floppy device
driver which has been set
up in preferences.

Check that the floppy disk
device name is correct;
refer to Using Floppy Disks,
Chapter 2.

The floppy device name is
invalid for the type chosen.

The floppy device name
is invalid for the floppy
device type. Typically no
name with a non-null type,
or a name when the type
is none.

Reset the settings in the
Open Disk Drives dialog
box.

Floppy A: and floppy B:
cannot be the same device

You have attempted to
select the same device for
A: and B:.

Specify a different device.

FSA drives

The host filesystem
directory cannot be found.

The directory specified for
an FSA drive cannot be
found.

Check that the directory has
not been renamed, moved, or
deleted.

The host filesystem must
be a directory.

An FSA drive has been
given the name of an
ordinary file.

Specify a directory.

The host filesystem must
have read access.

The directory for an FSA
drive cannot be read.

Check the file access
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.
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Error Explanation Suggestion

COM/LPT ports

Output error. DEC
SoftWindows was unable
to write to the specified
queue.

DEC SoftWindows has one
of its COM or LPT ports
configured to output to a
queue but can no longer
output to it.

Check that the queued
process has not quit.

The communications
device name is invalid.

The name of the file,
queue, or device selected
for a COM or LPT port is
not valid.

Check the name in the
appropriate dialog box.

Device needed by
comms adapter could
not be accessed - check
permissions.

A device set up for a COM
or LPT port cannot be
accessed.

Check the file access
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.

Process requested in
comms adapter could
not be found.

The queue set up for a
COM or LPT port cannot
be found.

Check the name in the
appropriate dialog box.

Exiting DEC SoftWindows

The DEC SoftWindows
resource file could not
be created.(It will not be
updated.)

DEC SoftWindows cannot
create one of its ancillary
files.

Check the home file
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.

The DEC SoftWindows
resource file could not be
updated. Continuing will
attempt to create the file
in SYS$LOGIN.

DEC SoftWindows cannot
update one of its ancillary
files.

Check the home file
permissions; refer to How
Do I Check File Access
Permissions? earlier in
this chapter.
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Glossary

AUTOEXEC.BAT
A special batch file that is executed each time the PC boots up.

Batch file
A text file containing MS–DOS commands that can be executed
to run the commands it contains, as if they were typed in at the
keyboard.

Boot
The PC terminology for starting up the computer.

CGA
Color Graphics Adapter, a display standard available for the PC.

Communication port
The name given to the interface which can be used to connect a
modem. This is also known as the serial communication port.

COM1, COM2, COM3, COM4
The names of the four serial communication ports supported by
MS–DOS.

Configuration file
The file that contains the information that determines which
printers, disk drives, and other devices will be available to you
when you run DEC SoftWindows.

CONFIG.SYS
A special MS–DOS text file that contains commands to configure
the MS–DOS operating system.

Copy protection
A routine embedded in commercial software that prevents users
from making unauthorized copies.

Current directory
The directory in which MS–DOS looks for files.

Current drive
The drive on which MS–DOS looks for a directory or a file.
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Device
A piece of hardware, eg a printer, that performs a specific task.

Device name
The name used to refer to a device; eg LPT1: and LPT2: are used
to refer to printers.

Directory
A division or level in an hierarchical file storage system that can
include files and other directories.

Drive letter
The letter used to identify a drive; eg A:, B:, C: to Z:.

Emulated hard drive
A file located in your file system which has an MS–DOS file
system layout. This allows it to emulate a hard drive and
function like a PC hard drive. Drives C: and D: are set up as
emulated hard drives.

Expanded memory
The LIM (Lotus, Intel, Microsoft) standard for increasing the
amount of memory available to PC applications beyond the
original 640 Kbyte.

Extended memory
The XMS (Extended Memory System) standard for increasing
the amount of memory available to PC applications using 80286
protected mode.

Extension
The last part of an MS–DOS file name which can be used to
specify the type of file. It consists of a period and up to three
letters; eg .BAT.

File
A collection of data stored on a hard disk, floppy disk, tape, or
CD-ROM under a single name.

File permissions
Refer to Permissions.

FSA
File Sharing Architecture.

FSA drive
A name for a drive that is treated by the PC as being on
a different computer. FSA drives cannot be formatted or
partitioned. DEC SoftWindows allows you to set up Unix
directories as FSA drives.
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Home directory
Your default Unix directory; ie the one you use for storing
personal work, files associated with your user account, and other
directories.

Microsoft mouse
A popular type of a hand-held pointing tool that can be used
with MS–DOS applications in a DEC SoftWindows window. DEC
SoftWindows provides you with an emulated Microsoft Mouse.

Modem
A device that enables a machine or terminal to establish a
connection and transfer data through telephone lines. The name
derives from the technique it uses: modulation and demodulation.

MS–DOS
Microsoft Disk Operating System; the system software and filing
system used on IBM PC or compatible computers.

NET USE
The command used to create extended drives from DEC
SoftWindows to the Unix operating system.

Path
A sequence of directory names, separated by a backslash in
MS–DOS (\) or a forward slash in Unix (/).

PC
An abbreviation for a personal computer such as an IBM Personal
Computer or compatible.

Permissions
The name given to settings that are assigned to each file and
directory to determine which users have access to read, write, or
execute its contents.

Port
The name for a serial or parallel interface on a PC. Referred to as
COM or LPT ports, respectively, by MS–DOS.

PostScript
The name of a page-description language designed by Adobe
for producing typefaces and graphics on different printers.
Applications use the PostScript language to describe to printers
how graphics and type should appear.

Printer
A device that prints data and text on paper. A local printer is
the printer attached directly to your computer or workstation. A
remote printer is accessed across the network and is not directly
connected to your computer or workstation.
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Printer queue
A temporary queue of jobs, or files in MS–DOS, waiting to be
printed on a particular printer.

Prompt
A request, displayed by the computer, that asks you to provide
some information or perform an action; eg the MS–DOS prompt is
usually C:\>.

Read permission
A file setting that allows you, members of your group, or other
users to read a file.

Reboot
A procedure that restarts a computer or DEC SoftWindows.

Root
The name of the user who can access all files without restriction.
The system administrator always has root access.

Root directory
The highest level directory in the hierarchical filing system.

Serial port
The communications port, labeled COM1: or COM2:, to which you
can attach devices, such as a modem.

Server
A system on a network that provides resources to other systems,
such as disks and printers.

SVGA
Super Video Graphics Array, an extension of VGA.

System administrator
The person in charge of performing administrative tasks on a
system.

Text editor
An application used to create or change text files. The standard
MS–DOS text editor is referred to as EDIT.

Text file
Data contained in a file that you can read because it contains
ordinary letters, numbers, and punctuation marks.

VGA
Video Graphics Array, the most widely accepted standard for PC
graphics displays.
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Volume
An alternative name for a disk.

Windows
A user interface for PCs which provides windows, icons, menus,
and mouse control.

Write enabling
A method of allowing data to be written to a disk.

Write protection
A method of preventing new data from being written to a disk,
and preventing any existing data from being overwritten.
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Index

A
A: drive, 3–14
Activate (Actions menu), 2–17
applications

installing, 6–6
running, 6–7

Attach Floppy (Actions menu), 2–14
Attach Mouse (Actions menu), 2–7
AutoFlush (Options menu), 4–2
Auto Freeze (Options menu), 2–6

B
B: drive, 3–14
Banyan Vines, 5–9

C
C: drive, 3–5
CD (MS–DOS command), 7–4
CD-ROM drives

device name, 3–15
in AUTOEXEC.BAT, 3–15
setting up, 3–15

CD-ROMs
interfacing, 1–3
troubleshooting, 10–2
using, 2–15

CGA display, 3–16
Comm Ports (options menu), 4–5
Comm Ports (Options menu), 4–7
Comms ports

activating\deactivating, 2–17
configuration file

saving, 2–6
COPY (MS–DOS command), 7–4
copying text between windows, 2–13

D
D: drive, 3–5
Data Comm (Comm Ports option), 4–6
DEC SoftWindows

restarting, 3–1
running on a second workstation, 9–1
setting up, 3–1

defaults
serial printer, 4–4

DEL (MS–DOS command), 7–5
DIR (MS–DOS command), 7–5
directory

listing OpenVMS, 3–12
removing OpenVMS from drive, 3–12

Disk Drives (Options menu), 3–1, 3–4
Display (Options menu), 3–1, 3–16
display, setting up, 3–16
/DOS_TO_VMS qualifier, 3–12
drive F:, 2–15
drivers

installing, 6–3
drives

activating\deactivating, 2–17
defaults, 3–4

E
E: drive

setting up, 3–10
E: to K: drives, 3–11
EDIT (MS–DOS command), 7–1
EGA display, 3–16
Enable Automatic Flushing option, 4–3, 4–5
error messages

FSA, 10–8
MS–DOS, 10–7
networking, 10–9
SoftWindows, 10–10

Ethernet 802.2, 5–12
Ethernet 802.3, 5–13
Ethernet frame types, 5–12
Ethernet II, 5–12
Ethernet SNAP, 5–13
exit

from Windows, 2–3
Exit (File menu), 2–6
exiting

from DEC SoftWindows, 2–6
expanded memory, 1–4
Expanded memory, 3–2
extended memory, 1–4
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F
file

outputting to, 4–5
file access permissions, 10–13

checking, 10–4
setting, 10–3

files
sharing OpenVMS and MS–DOS, 3–12

file servers
LAN Manager, 1–4
NetWare, 1–4

floppy disk
to format, 2–14

floppy disk drives
deassigning, 3–14
interfacing, 1–3
setting up, 3–14
using, 3–14

floppy disks
troubleshooting, 10–1
using, 2–14

flushing, 4–1
automatically, 4–2
manually, 4–2

Flush Ports (Action menu), 4–2
fonts

adding, 6–5
FORMAT, 2–14
FORMAT (MS–DOS command), 7–5
FPU emulation (Options menu), 2–16
Freeze (Actions menu), 2–6
FSA

error messages, 10–8
FSA drives

interfacing, 1–3
setting up, 3–10

G
glossary, Glossary–1

H
hard disk files

choosing, 3–5
creating, 3–6
interfacing, 1–3
removing, 3–8
sharing, 10–1
using, 3–4

hard disks
troubleshooting, 10–1

HELP (MS–DOS command), 7–6
Hercules display, 3–16

I
interfacing

CD-ROMs, 1–3
floppy disk drives, 1–3
FSA drives, 1–3
hard disk files, 1–3

K
keyboard, 2–8
Keyboard, 2–8

functions in MS–DOS, 2–10
functions in MS-DO S, 2–11

keyboard layout
changing, 6–4

Keyboard mapping, 2–10
workstation to PC, 2–10

keyboards, 1–3
troubleshooting, 10–2

L
LAN Manager file servers, 1–4
LAN Workplace for DOS, 1–4
LPT ports

activating\deactivating, 2–17

M
Main memory, 3–2

size, 3–3
memory

changing, 6–2
Expanded, 6–2
Main, 6–2
setting up, 3–2, 6–2
troubleshooting, 10–2

Memory (Options menu), 3–1, 3–3, 6–2
Microsoft LAN Manager, 5–7
MKDIR (MS–DOS command), 7–6
mouse, 1–3

disappearing, 2–7
troubleshooting, 10–2
using, 2–7

MSCDEX (MS–DOS command), 3–15
MS–DOS

error messages, 10–7
filenames, 3–10
using, 2–4

MS–DOS applications
disk space requirements, 7–9
installing from floppies, 7–8
installing over the network, 7–8

MS–DOS commands
CD, 7–4
COPY, 7–4
DEL, 7–5
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MS–DOS commands (cont’d)
DIR, 7–5
EDIT, 7–1
FORMAT, 7–5
HELP, 7–6
MKDIR, 7–6
PRINT, 7–6
RMDIR, 7–6
TYPE, 7–7
XCOPY, 7–7

MS–DOS Editor, 7–1

N
NET USE (MS–DOS command), 3–12
NetWare file servers, 1–4
networking

Banyan Vines, 5–2
error messages, 10–9
Novell NetWare, 5–2
packages, 5–3
TClP/IP, 5–2
troubleshooting, 10–5

Novell LAN Workplace for DOS, 5–11
Novell NetWare, 5–5

O
OpenVMS directories, 3–12

setting up, 3–11
OpenVMS filenames

conversion to MS–DOS, 3–10
Options menu, 3–1

P
pasting text between windows, 2–13
PC applications

troubleshooting, 10–5
PRINT (MS–DOS command), 7–6
printer driver

installing, 6–4
selecting, 6–3

Printer Ports (Options Menu), 4–4
printers

troubleshooting, 10–2
printing, 4–1

to a network printer, 4–3
to an OpenVMS printer, 4–3
to a serial printer, 1–4, 4–3
to a text file, 1–4

R
requirements

DEC SoftWindows, 1–6
resize

MS–DOS window, 2–4

Restart (Actions menu), 2–5
restarting

DEC SoftWindows, 3–1
RMDIR (MS–DOS command), 7–6

S
serial ports, 4–4
setting up

DEC SoftWindows, 3–1
SoftNode, 5–1
SoftWindows

error messages, 10–10
SoftWindows Display drives, 10–6
SoftWindows Mouse drives, 10–6
specifications, 1–5
SWINCONFIG.INI file, 8–1
system configuration file, 8–1

T
terminal support, 1–3
text files

sharing OpenVMS and MS–DOS, 3–12
troubleshooting

CD-ROMs, 10–2
floppy disks, 10–1
hard disks, 10–1
keyboards, 10–2
memory, 10–2
mouse, 10–2
networking, 10–5
PC applications, 10–5
printers, 10–2

TYPE (MS–DOS command), 7–7

V
VGA display, 3–16
VMS_TO_DOS qualifier, 3–13

W
Windows

installing on hard disk, 3–9
resizing, 2–1
setting up, 6–1
using, 2–1

Windows applications
installing, 6–6

X
XCOPY (MS–DOS command), 7–7
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